RDM Upgrading and Migration
## Contents

### Chapter 1. Upgrading Design Management Server

- Upgrading the Rational Software Architect Design Management client ........................................ 1

### Chapter 2. Installing and configuring Design Management

- Installing Design Management ..................................................................................................... 4
- Hardware and software requirements ....................................................................................... 5
- Installation prerequisites ............................................................................................................. 6
- Planning the deployment and installation ................................................................................ 6
  - Choosing an installation topology ......................................................................................... 7
- Downloading the product installation media ............................................................................. 9
- Installing Design Management .................................................................................................. 10
- Setting up the database ............................................................................................................. 12
  - Setting up a DB2 database ..................................................................................................... 12
  - Setting up an Oracle database ............................................................................................... 13
  - Setting up an SQL Server database ...................................................................................... 15
- Deploying the Design Management Server on WebSphere Application Server .................. 17
- Setting up and configuring the Design Management Server by using express setup .......... 21
- Setting up and configuring the Design Management Server .................................................. 31
  - Setting up the CLM applications (optional) ......................................................................... 31
  - Configuring the Design Management application .................................................................. 32
  - Setting up quality management and requirements management and lifecycle project administration applications ........................................................................................................ 33
- Summary .................................................................................................................................. 33
- Installation summary ................................................................................................................ 33
- Adding domain extension servers to host Rational Software Architect content .................. 33
- Changing the public URL using server rename ...................................................................... 34
- Installing optional tools, client extensions, and samples ......................................................... 35
  - Installing Rational Software Architect components .......................................................... 35
  - Installing Rational Rhapsody components ......................................................................... 38

### Chapter 3. Sharing Rational Software Architect models

- Rational Software Architect Design Manager Import Engine .................................................. 45
- Configuring the import engine .................................................................................................. 46
- Creating import definitions for Design Management Server .................................................... 48
- Requesting import operations for Design Management Server .............................................. 49
- Ant scripts for pulling model content onto the Design Management Server ......................... 50
- Troubleshooting the Rational Software Architect Design Manager Import Engine ............ 51

### Chapter 4. Importing Rational Rhapsody models to the Design Management Server

- Importing models to the server ............................................................................................... 53
- Importing Rational Rhapsody models manually ..................................................................... 53
- Creating an import definition .................................................................................................... 53
- Configuring the Rational Rhapsody Design Manager Import Engine .................................... 54
- Troubleshooting Rational Rhapsody Design Manager Import Engine ................................ 55

### Chapter 5. Importing MathWorks Simulink models to the Rational Rhapsody Design Management Server

- Manually importing MathWorks Simulink models ................................................................. 58
  - Configuration ......................................................................................................................... 58
  - Export models to the Rational Rhapsody Design Management Server ................................ 58
- Navigating to MathWorks Simulink models in Rational Rhapsody Design Manager ............ 59

### Index

................................................. 61
Chapter 1. Upgrading Design Management Server

Upgrading Design Management Server involves going from versions 4.0, 4.0.1, 4.0.2 to version 4.0.3 of the applications.

About this task

For complete Design Management Server 4.0 upgrade details, see this Jazz.net article.

The Design Management Server upgrade process is very similar to the Rational solution for Collaborative Lifecycle Management (CLM) upgrade process; see the CLM link below for details.

To learn how to migrate comments and links created in version 3 releases of Design Management Server to 4.0.1 or later, see the tutorial link below.

Related information:

- Upgrading the Rational solution for CLM
- Tutorial: Migrate data from Design Management 3.0
- Client and server version compatibility

Upgrading the Rational Software Architect Design Management client

When upgrading Rational Design Management, you must upgrade the Rational Software Architect Design Management client.

Procedure

1. Log on to your computer or local area server as a user with administrator permission.
2. Go to the RSADM_Setup or RhapsodyDM_Setup and run the Launchpad file.
   - Windows: Run launchpad.exe.
   - Linux: Run launchpad.sh.
3. In the launchpad, under IBM Rational Software Architect Design Manager Server or IBM Rational Rhapsody Design Manager Server click Install the Client.
4. Click Rational Software Architect - Design Manager Client Extension. IBM® Installation Manager opens and lists the Design Management packages, and the version of IBM Installation Manager that installs them.
5. In IBM Installation Manager, select the client that corresponds to your modeling product, IBM Rational Software Architect Design Management Client Extension for versions other than Rational Software Architect 9 or IBM Rational Software Architect Design Management Client Extension for RSA 9, and then click Next.
6. Review the license agreement, accept it if you agree to it, and then click Next.
7. Accept the default shared resources directory, or enter a different location, and then click Next.
8. On the Features page, review the packages and click **Next**.
9. On the Summary page, click **Install**.
10. Click **Finish** when the installation is complete to close Installation Manager.
Chapter 2. Installing and configuring Design Management

For version 4 releases of Design Management, the supported installation scenarios include the installation of Design Management as a stand-alone product with its own Jazz™ Team Server, or installation of Design Management along with Rational® solution for Collaborative Lifecycle Management (CLM) environment in which several applications share a common Jazz Team Server.

About this task

Supported infrastructure

For a list of supported configurations see System requirements and supported configurations.

Design Management internal topology

The following figure shows the internal topology of an installation of Design Management along with Rational solution for Collaborative Lifecycle Management (CLM) environment with several applications.
Version 3 releases of Design Management stored user and administration information in its own database and could be a friend server to the Jazz Team Server. Version 4 releases of Design Management have a database to store Design Management application data, but user and other administration information no longer resides in a Design Management database: it resides in the Jazz Team Server database. In addition, the Design Management application can share the same Jazz Team Server as other CLM applications. Version 4 releases of Design Management integrates more fully into a CLM environment so that administration tasks apply to all CLM products, including Design Management.

**Installing Design Management**

To install version 4 releases of Design Management, you must decide which setup to install. Two installation scenarios are supported: the installation of Design Management as a stand-alone product with its own Jazz Team Server, or installed along with Rational solution for Collaborative Lifecycle Management (CLM) environment in which several applications share a common Jazz Team Server.
Procedure

1. **Plan your installation and physical topology**

2. **Verify that your system meets the "Hardware and software requirements" and "Installation prerequisites" on page 6**

3. **Download packages for Design Management 4.0** You must choose whether Design Management is a stand-alone installation or an integration with other CLM applications.

4. **To install the downloaded packages complete the following task:** Install Design Management 4.0

5. If you are not using the default Derby database or Tomcat server, you must configure the database and server before configuring and setting up the applications. Review the following topics on setting up databases or WebSphere® Application Server. If you are using the default Derby database and Tomcat server, proceed to step 5.
   - To set up a commercial database other than the default Derby database, complete one of the following steps:
     - "Setting up a DB2 database" on page 12
     - "Setting up an Oracle database" on page 13
     - "Setting up an SQL Server database" on page 15
   - To deploy a WebSphere Application Server, complete the following step:
     - "Deploying the Design Management Server on WebSphere Application Server" on page 17

6. To configure the installed packages, complete one of the following step:
   - To install with the default Apache Derby database and with default settings complete the following task: Express Design Management Server configuration
   - To install with a database other than Apache Derby and also would like to configure email notifications, and data warehouse information, complete the following task: Custom Design Management Server configuration

7. Verify the installation, set up initial projects, and set up user accounts.

Example

Figure 1. Installation process for Design Management Server and its related tools. Click any box for more information.

Hardware and software requirements

Before you begin the installation, verify that your hardware and software meet the minimum requirements. A 64-bit operating system and a minimum of 8 GB of server memory provide the best environment for running Design Management Server.

Review the complete list of system requirements then, generate a report by selecting your product, version, and operating system and click Submit. To see the system requirements for fix pack releases, select the parent version of the product.

For a complete list of CLM system requirements, see System Requirements for the CLM 2013 Releases on Jazz.net.
**Important:** You can connect to a newer version server by using an older version client, but you cannot connect to an older version server by using a newer version client. The same principle applies between servers. Jazz Team Server must be at the same level as or newer than the Design Management Server applications, but the Design Management Server applications cannot have a newer version than Jazz Team Server. For more information, see the related information below.

**Related information:**
- [Client and server version compatibility](#)
- [Deployment wiki and community](#)

### Installation prerequisites

Before you install Design Management Server, review the following installation prerequisites.

- Uninstall any previous Design Management Server installations.
- If possible, install and configure the components on a computer that has a new installation of the operating system, and that has not had programs installed and uninstalled.
- Before you install Design Management Server, you must configure the web browser on the server to allow pop-up windows. Otherwise, you cannot install the server.

**Related information:**
- [Client and server version compatibility](#)
- [Deployment wiki and community](#)

### Planning the deployment and installation

An installation of the design management tools can include several different components. Before you install the software, review the hardware and software requirements, select an installation topology, and review the installation steps.

**About this task**

Design Management Server is an application that runs on Jazz Team Server, similar to the applications in the Rational solution for Collaborative Lifecycle Management. Jazz Team Server provides the basic services that enable a group of applications to work together, and Design Management Server provides services to work with models on the server. Therefore, many of the prerequisites and other installation steps for Design Management Server are the same as for Jazz Team Server.

In most cases, the complete installation includes the following components:

- The IBM Rational Software Architect Extension for Design Management or IBM Rational Rhapsody® Design Manager. You can install Design Management Server on a different application server as Jazz Team Server. In addition to Jazz Team Server, which hosts and manages projects, the Design Management Server hosts models so that users can comment on and collaborate on those models.
- A database for the Design Management Server, Data Warehouse, Configuration Management Server, and Jazz Team Server. You can install this database on the same application server or on an independent database server.
• One or more client applications. These clients can be computers with web browsers and access to the Design Management Server. They can also be installations of Rational Software Architect with the collaboration client extension, and Rational Rhapsody, depending on which extensions are installed on the server. These client applications provide access to the models that are hosted on the Design Management Server.

• One or more import engines, which import models to the server and keep the models up to date. You can install these import engines on the client computers, the application servers, or on the servers on which the models are stored. Separate import engines are available for Rational Software Architect models and for Rational Rhapsody models. You must install an import engine to import models to the server.

• One or more instances of IBM Installation Manager, which installs the other components.

You can install these components in several different configurations, as described in the different available installation topologies. You can also add other products to the installation later.

**Choosing an installation topology**

Choosing an appropriate topology is an important step in planning the installation of the design management tools.

**About this task**

You can install the components of the design management tools on the same server for a simple evaluation topology, or on independent servers for a distributed topology that provides greater capacity and that you can upgrade later.

Separate topologies are available for integration with Rational Software Architect and with Rational Rhapsody. In each case, three topologies are available:

**Evaluation topology**

All the components of the design management tools, including the server, the client, and the import engine, are installed on a single server. This type of topology is appropriate for evaluations, demonstrations, and training purposes; it is not ideal for production environments.

**Departmental topology**

The Design Management Server is installed on its own server, and the client software and import engine is installed on one or more client computers. The database for Jazz Team Server can be installed on the same server as the Design Management Server or on a separate server. This type of topology is appropriate for mid-sized deployments, such as a single department or team.

**Distributed topology**

The Design Management Server is installed on its own server, the client software is installed on one or more client computers, and one or more import engines are installed on source control servers. This topology provides the highest capacity and flexibility because it can import models from multiple source control servers and you can schedule regular updates of the model content.

You can integrate with both products at the same time following the same patterns in these topologies.
For more information about these topologies, see the following topics.

**Installation topologies for integration with Rational Software Architect**
You can install design management tools to integrate with Rational Software Architect in several different configurations, depending on your needs.

The following topics list some of the most common installation topologies.

**Evaluation topology example:**

The following example shows the simplest way to install Design Management Server to integrate with Rational Software Architect. This topology is appropriate for exploring the software or for training environments, but not for production environments.

In this example, all the design management software is installed on a single computer, including the Design Management Server, import engine, and Jazz Team Server. An installation of Rational Software Architect with the client extension acts as the client.

**Departmental topology example:**

The following example shows a design management topology that is appropriate for small team deployments and single server deployments.

In this example, the Design Management Server and its database are installed on separate servers. The clients host separate installations of Rational Software Architect and separate import engines.

If you install the software in this manner, use a stable, company-approved DNS and register it so that you can keep the data if you move to another deployment topology.

**Distributed topology example:**

The following example shows a design management topology that is appropriate for production-level deployment and integration with Rational Software Architect.

In this example, the database, import engine, and Design Management Server are each installed on a separate application server. The clients use web browsers and Rational Software Architect with the client extension to access the model server.

**Installation topologies for integration with Rational Rhapsody**
You can install design management tools to integrate with Rational Rhapsody in several different configurations, depending on your needs.

The following topics list some of the most common installation topologies.
Evaluation topology example:

The following example shows the simplest way to install Design Management Server to integrate with Rational Rhapsody. This topology is appropriate for exploring the software or for training environments, but not for production environments.

In this example, all the design management software is installed on a single computer, including the Design Management Server and import engine. An installation of Rational Rhapsody acts as the client.

Departmental topology example:

The following example shows a design management topology that is appropriate for small team deployments and single server deployments.

In this example, the Design Management Server server and its database are installed on separate servers. The clients host separate installations of Rational Rhapsody and separate import engines.

If you install the software in this manner, use a stable, company-approved DNS and register it so that you can keep the data if you move to another deployment topology.

Distributed topology example:

The following example shows a design management topology that is appropriate for production-level deployment and integration with Rational Rhapsody.

In this example, the database, import engine, and Design Management Server are each installed on a separate application server. The clients use web browsers and Rational Rhapsody to access the model server.

Downloading the product installation media

Download the IBM Rational Software Architect Extension for Design Management or IBM Rational Rhapsody Design Manager from Jazz.net, on the All Downloads tab.

Procedure

1. On Jazz.net, open the Design Management project at the following address: Design Management on Jazz.net
2. Click All Downloads and then click a version number.
3. On the All Downloads tab, under the headings for IBM Rational Software Architect Extension for Design Management and IBM Rational Rhapsody Design Manager, download the appropriate file for the Rational modeling product that you use.
Installing Design Management

After you download the Design Management packages from Jazz.net, use the launchpad to install IBM Installation Manager and then install Design Management. The installation process creates the proper folder structure and the files required to set up and configure Design Management.

Before you begin

Ensure that you extracted all the files to the same location. After extraction, you should have a directory named `RSADM`. If you downloaded the files individually, you should have the `RSADM_Setup` directory or the `RhapsodyDM_Setup` directory. If you are installing any Rational solution for Collaborative Lifecycle Management (CLM) applications, you will have additional directories related to CLM.

Procedure

1. Log on to your computer or local area server as a user with administrator permission.
2. Go to the `RSADM_Setup` or `RhapsodyDM_Setup` and run the Launchpad file.
   - Windows: Run `launchpad.exe`.
   - Linux: Run `launchpad.sh`.
3. In the launchpad, under IBM Rational Software Architect Design Manager Server or IBM Rational Rhapsody Design Manager Server click Install the Server.
4. Choose custom or express install based on your install topology. If you are installing on multiple servers, click Custom Installation and select either install the Jazz Team Server or Install applications without Jazz Team Server. IBM Installation Manager will display and list the Design Management packages, and the version of IBM Installation Manager that installs them.
5. In IBM Installation Manager, select the check boxes to install the server that corresponds to your modeling product, and the Jazz Team Server, and then click Next.

   **Note:** If you are using Rational Software Architect, you need to select IBM Rational Software Architect Extension for Design Management Domain Extension Application.

   **Note:** If you are installing other CLM applications, you must select which installation packages to include such as Change and Configuration Management, Quality Management, or Requirements Management. The following diagram shows the selection of a IBM Jazz Team Server along with other CLM applications. If you have a multiple or enterprise installation scenario, select only the Jazz Team Server or applications to install in this installation package or server. You must then use IBM Installation Manager on the new server, or restart after the installation and select another application and a different installation package location in step 8.

   **Note:** If you are planning to install and use Requirements Manager and Design Manager applications together, you must make sure that Requirements Manager (converter.war) application and Design Manager (dm.war and vcc.war) applications are deployed on separate application servers. If these applications are deployed on the same application server, errors might occur that prevent the Converter application to display graphics.
6. On the Prerequisite page, verify the packages and click **Next**.

7. For each component that you install, you must review the license agreement, accept it if you agree to it, and then click **Next**.

8. Accept the default shared resources directory, or enter a different location, and then click **Next**.

9. Select the languages to install and then click **Next**.

10. On the Features page, review the packages and click **Next**.

11. On the Common Configurations page, you can specify which server to use. If you are installing Design Management Server on Apache Tomcat, select the **Install Tomcat 7** check box. If you are using another application server, such as WebSphere Application Server, clear the check box and under **Alternative Web Application Deployment Location**, specify the location for the web application files.

The following diagram shows the installation of the Apache Tomcat 7 server.

12. Click **Next**.

13. On the Context Root page, select the appropriate option. To use a custom context root for each application, click the custom option and, in the table below, type a context root for the application and click **Next**.

14. On the Summary page, click **Install**.

15. To complete the installation, click **Finish** and when the installation process completes, close IBM Installation Manager. If you are using a multiple installation scenario, click **Install** to add additional applications in a different installation package folder.
Before you start the server, ensure that you do not have any other web servers running on the default port for the Design Management Server, which is 9443. If you need to run the Design Management Server on a different port, change the port number:

a. Before you start the server, open the file named `Installation_Directory/server/tomcat/conf/server.xml` in a text editor. In this case, `Installation_Directory` is the folder in which you installed the server.

b. In the `server.xml` file, replace all instances of port 9443 with an alternate port number that is available.

c. Save and close the file. Remember the port number because you need it to configure the server.

What to do next

If you are using Apache Tomcat, you can now set up the server as described in “Setting up and configuring the Design Management Server” on page 24. If you are using a different application server, you can now deploy the Design Management Server on that application server; see “Deploying the Design Management Server on WebSphere Application Server” on page 17.

Setting up the database

If you are using a database other than the included default Derby database you will need to complete additional pre-setup configurations for the particular database before using the Design Management configuration setup. Setting up the database for Design Management Server involves creating the databases for the applications on the server, configuring the properties files for the databases, and creating tables on the databases. In most cases, you use the setup wizard to automatically configure the properties files and create the tables.

Fast path: If you are using the included Derby database, no additional setup is necessary. You can proceed to “Installing Design Management” on page 10 to configure the Derby database for Design Management.

Related tasks:
- “Setting up a DB2 database”

Related information:
- Deployment wiki and community

Setting up a DB2 database

Setting up a DB2® database for Design Management Server involves creating individual databases for each application that runs on the server. Then, you configure the databases and create tables on them; in most cases the setup wizard completes these steps for you.

Before you begin

Note: These instructions do not apply to installing or configuring a database on z/OS®.

Consult the DB2 documentation or your database administrator to ensure that you meet the following prerequisites:

- Ensure that you installed one of the following supported versions of DB2 on the database server:
– DB2 9.7 Enterprise Server Edition
– DB2 9.7 Workgroup Server Edition
– DB2 9.7 Express-C

You can install the database on the model server or on a separate database server.

• Ensure that you have the user name and password for the DB2 instance user; the default user name is db2inst1.
• Review the DB2 documentation to verify that your system meets the requirements and is configured correctly.
• Ensure that DB2 is running. As the DB2 instance user, run the db2start command, or start the database server from the DB2 control center.

Procedure

1. Open a DB2 command window by logging in as the DB2 instance owner and typing the command db2 at a command prompt.
2. Create a total of 4 databases one each for Jazz Team Server (JTS), Data Warehouse (DW), Design Management (DM), and Configuration Management (VVC), with 16K pages and the UTF-8 code set by running the following command on a single line, replacing <db_varname> with database names JTS, DW, DM, and VVC:

   ```sql
   create database <db_varname> on <location> using codeset UTF-8 territory en PAGESIZE 16384
   
   For location, use the location on disk where you want to store the database or remove it to use the default location.
   
3. Optional: Create a separate user at the operating-system level to access the data warehouse database and grant that user administrative privileges over the database. The default user name for the data warehouse user is RPTUSER. For example, to grant the user RPTUSER administrative privileges, use the following commands:

   ```sql
   connect to DW
   grant DBADM on database to user RPTUSER
   
4. Run the command quit to exit the DB2 command window.

What to do next

If you use the Design Management Server setup wizard to configure the server, no further database customization is necessary. This setup wizard configures the databases and creates the necessary tables.

If you are not running the setup wizard, you can customize the databases manually; for information, see Setting up a DB2 database in the Rational Team Concert installation documentation.

Related concepts:

“Setting up the database” on page 12

Related information:

Deployment wiki and community

Setting up an Oracle database

Setting up an Oracle database for Design Management Server involves configuring the database system, creating the database, and setting up tablespaces and users.
Before you begin

Install Oracle on the database server and make sure that you have the necessary permissions to access the database server and to create and modify databases. Ensure that the database server is properly configured; for example, you may need to set the following system variables:

- Set `ORACLE_HOME` to the Oracle installation directory.
- Set `ORACLE_SID` to the Oracle system ID for the database server.
- Set `ORACLE_JDBC_DRIVER_FILE` to the location of the Oracle JDBC JAR file, which is named `ojdbc5.jar`.

Important: The following configuration parameters and tablespace options are examples. Your environment might require different parameters and options.

Procedure

1. Using the Oracle SQL*Plus command-line tool or the database configuration assistant, create an Oracle database with UTF-8 encoding for the Jazz Team Server (JTS), Design Management Server (DM), Configuration Management Server (VVC), and another database for the data warehouse (DW). Use Shared Server Mode as the connection mode. For specifics, see the Oracle database help.

2. Using SQL*Plus, create two tablespaces in each database. The following code is an example:

   ```
   CREATE TABLESPACE JTS
   DATAFILE 'C:\oraclexe\app\oracle\oradata\jts01.dbf'
   SIZE 1G AUTOEXTEND ON EXTENT MANAGEMENT LOCAL AUTOALLOCATE;
   CREATE TEMPORARY TABLESPACE JTS_TEMP
   TEMPFILE 'C:\oraclexe\app\oracle\oradata\jttmp01.dbf'
   SIZE 20M AUTOEXTEND ON EXTENT MANAGEMENT LOCAL UNIFORM SIZE 1M;
   CREATE TABLESPACE DM
   DATAFILE 'C:\oraclexe\app\oracle\oradata\dm01.dbf'
   SIZE 1G AUTOEXTEND ON EXTENT MANAGEMENT LOCAL AUTOALLOCATE;
   CREATE TEMPORARY TABLESPACE DM_TEMP
   TEMPFILE 'C:\oraclexe\app\oracle\oradata\dmtmp01.dbf'
   SIZE 20M AUTOEXTEND ON EXTENT MANAGEMENT LOCAL UNIFORM SIZE 1M;
   CREATE TABLESPACE VVC
   DATAFILE 'C:\oraclexe\app\oracle\oradata\vvc01.dbf'
   SIZE 1G AUTOEXTEND ON EXTENT MANAGEMENT LOCAL AUTOALLOCATE;
   CREATE TEMPORARY TABLESPACE VVC_TEMP
   TEMPFILE 'C:\oraclexe\app\oracle\oradata\vvctmp01.dbf'
   SIZE 20M AUTOEXTEND ON EXTENT MANAGEMENT LOCAL UNIFORM SIZE 1M;
   CREATE TABLESPACE DW
   DATAFILE 'C:\oraclexe\app\oracle\oradata\dw01.dbf'
   SIZE 1G AUTOEXTEND ON EXTENT MANAGEMENT LOCAL AUTOALLOCATE;
   CREATE TEMPORARY TABLESPACE DW_TEMP
   TEMPFILE 'C:\oraclexe\app\oracle\oradata\dwtmp01.dbf'
   SIZE 20M AUTOEXTEND ON EXTENT MANAGEMENT LOCAL UNIFORM SIZE 1M;
   ```

3. Create a user for each tablespace and grant the users permissions to work with the database. The following code is an example:

   ```
   CREATE USER JTSUSER IDENTIFIED BY JTSUSER DEFAULT TABLESPACE JTS QUOTA UNLIMITED ON JTS TEMPORARY TABLESPACE JTS_TEMP;
   CREATE USER DMUSER IDENTIFIED BY DMUSER DEFAULT TABLESPACE DM QUOTA UNLIMITED ON DM TEMPORARY TABLESPACE DM_TEMP;
   CREATE USER VVCUSER IDENTIFIED BY VVCUSER DEFAULT TABLESPACE VVC QUOTA UNLIMITED ON VVC TEMPORARY TABLESPACE VVC_TEMP;
   CREATE USER DWUSER IDENTIFIED BY DWUSER DEFAULT TABLESPACE DW QUOTA UNLIMITED ON DW TEMPORARY TABLESPACE DW_TEMP;
   GRANT CREATE PROCEDURE, CREATE SESSION, CREATE TABLE, CREATE VIEW TO JTSUSER;
   GRANT CREATE PROCEDURE, CREATE SESSION, CREATE TABLE, CREATE VIEW TO DMUSER;
   GRANT CREATE PROCEDURE, CREATE SESSION, CREATE TABLE, CREATE VIEW TO VVCUSER;
   GRANT CREATE PROCEDURE, CREATE SESSION, CREATE TABLE, CREATE VIEW TO DWUSER;
   ```
Setting up an SQL Server database

To set up a SQL Server database to use with Design Management Server, you can either use the command line or a visual tool such as SQL Server Studio Management.

Before you begin

- Install SQL Server with case-sensitive database collation selected as the default setting.
- Ensure that the server security is in the mode named SQL Server and Windows Authentication Mode.
- Enable the TCP protocol for SQL Server:
  1. From the Start menu, run the SQL Server Configuration Manager.
  2. Expand SQL Server Network Configuration > Protocols for instanceName.
  3. Right-click the TCP/IP protocol and then click Enable.
  4. Restart the SQL Server service by double-clicking SQL Server Services, right-clicking the running service, and then clicking Restart.
- Install the Microsoft SQL Server JDBC driver version 2.0 on the model server. This driver is available here: [SQL Server JDBC driver download](#). Version 3.0 is not supported; for more information, see [Unable to run Rational Team Concert server using Microsoft SQL JDBC driver 3.0](#).
- Log in as a user who is a member in the sysadmin fixed server role or an owner of the database.

**Important:** If you install Jazz Team Server with the Change and Configuration Management or Quality Management applications either on the same computer or distributed platforms, create a separate database and a user that is associated with that database.

- Install a tool to work with the database. You can either use the `sqlcmd` command-line tool, which is provided with the SQL server installation, or install SQL Server Management Studio.
  
  **To enable the `sqlcmd` tool:**
  1. From the Start menu, run the SQL Server Configuration Manager.
  2. Expand SQL Server Network Configuration > Protocols for instanceName.
  3. Double-click the Named Pipes protocol.
  4. Enable the named pipes protocol and specify the following name in the Pipe Name field:
     \pipe\sql\query
  5. Click OK.
  6. Restart the SQL Server Service by double-clicking SQL Server Services, right-clicking the running service, and then clicking Restart.

- Ensure that SQL Server and SQL Server Browser are running on the database server.

Procedure

The following instructions assume that you are using the `sqlcmd` tool, but you can also use the SQL Server Management Studio.
1. On the database server, while logged in as a database administrator, open a
   command prompt window and run the `sqlcmd` command to connect to the
database. For example, you can run this command:
   
   sqlcmd -S localhost\instanceName

   Use the name of the database instance for `instanceName`.

2. While connected to the database, run the following commands to create a
database and user for the Jazz Team Server application:
   
   ```
   CREATE DATABASE JTS
   GO
   CREATE LOGIN jtsDBuser
   WITH PASSWORD = 'jtsDBpw';
   USE JTS;
   exec sp_changedbowner 'jtsDBuser'
   GO
   ```

3. Run the following command to change the collation setting for the database:
   
   ```
   ALTER DATABASE JTS COLLATE SQL_Latin1_General_CP437_CS_AS
   GO
   ```

4. Run the following command to change the row version system for the
database:
   
   ```
   ALTER DATABASE JTS SET READ_COMMITTED_SNAPSHOT ON
   GO
   ```

5. Similarly, configure 3 additional databases for Design Management Server
   (DM), the data warehouse (DW) and Configuration Management Server (VVC)
substituting the `<DB_name>` for the names of the databases (DM, DW, and
VVC).
   
   a. Create the database and user:
      
      ```
      CREATE DATABASE <DB_name>
      GO
      CREATE LOGIN <DB_name>DBuser
      WITH PASSWORD = '<DB_name>DBpw';
      USE <DB_name>;
      exec sp_changedbowner '<DB_name>DBuser'
      GO
      ```

   b. Change the collation setting:
      
      ```
      ALTER DATABASE <DB_name> COLLATE SQL_Latin1_General_CP437_CS_AS
      GO
      ```

   c. Change the row version system:
      
      ```
      ALTER DATABASE <DB_name> SET READ_COMMITTED_SNAPSHOT ON
      GO
      ```

6. Close the database connection with the command `exit`.

7. If you are connecting to your SQL Server database using WebSphere
   Application Server with JRE 5.0 or the version of Tomcat that is included with
theDesign Management Server, set the `SQLSERVER_JDBC_DRIVER_FILE` system
variable on the Design Management Server to point to the JRE 5.0 version of
the JDBC driver named `sqljdbc.jar`.

   **Note:** Do not use spaces in file paths to the JDBC driver. For the Program Files
directory on 32-bit systems, you can use `PROGRA~1`. For the Program Files (x86)
directory on 64-bit systems, you can use `PROGRA~2`.

8. If you are connecting to the SQL Server database using WebSphere Application
Server with JRE 6.0 or if you want to configure your tomcat server to use Java
Runtime Environment 6.0, perform the following steps:
   
   a. Set the `SQLSERVER_JDBC_DRIVER_FILE` system variable to point to the JRE 6.0
   version of the JDBC driver named `sqljdbc4.jar`. 
b. Specify the location of the JRE in the following files:

- **Windows**
  - `installDir/server/repotools-jts.bat`
  - `installDir/internal/repotools/repotools.bat`

- **Linux**
  - `installDir/server/repotools-jts.sh`
  - `installDir/internal/repotools/repotools.sh`

Each of these files defines a variable named `JAVA`, as in the following example:

```bash
if [ "uname" = Darwin ];
then
    JAVA="/usr/bin/java"
    VMARGS="$VMARGS -XX:MaxPermSize=384m"
    DEFINE="$DEFINE -Dcom.ibm.team.repotools.rcp.allowInvalidBundles=true"
else
    JAVA="$START_DIR/jre/bin/java"
fi
```

Change each assignment statement for this variable to the location of the JRE. The resulting code looks like this, with your JRE location in place of `jreLocation`:

```bash
if [ "uname" = Darwin ];
then
    JAVA="jreLocation/bin/java"
    VMARGS="$VMARGS -XX:MaxPermSize=384m"
    DEFINE="$DEFINE -Dcom.ibm.team.repotools.rcp.allowInvalidBundles=true"
else
    JAVA="jreLocation/bin/java"
fi
```

c. Save and close the files.

**What to do next**

If you use the Design Management Server setup wizard to configure the server, no further database customization is necessary. This setup wizard configures the databases and creates the necessary tables.

If you are not running the setup wizard, you can customize the databases manually; for information, see Setting up an SQL Server database in the Rational Team Concert installation documentation.

**Deploying the Design Management Server on WebSphere Application Server**

You can deploy the Design Management Server on WebSphere Application Server instead of the Apache Tomcat server that comes with the server. The instructions are based on WebSphere Application Server version 8.0, with slight variations for versions 7.0 and 6.1.

**Before you begin**

**Important:** There is the potential for security exposure when using WS-Security; this could result in a user gaining elevated privileges. This impacts applications using JAX-WS and JAX-RPC. For complete details on how to obtain and install this security patch, read this news flash. In addition, consider subscribing to
WebSphere Application Server updates through My Notifications; therefore, you will receive security-related notices for updates and patches.

Fast path: If you installed Apache Tomcat in the setup wizard, no manual deployment steps are necessary. Proceed to “Setting up and configuring the Design Management Server” on page 24.

Ensure that your environment is set up correctly:
- WebSphere Application Server is installed.
  Jazz Team Server, which provides the foundation for Design Management Server, requires WebSphere Application Server Version 8.0.0.3, or WebSphere Application Server Version 7.0, or WebSphere Application Server Version 6.1 with Fixpack 27.
- If you are using a database other than Apache Derby, the database is set up as described in “Setting up the database” on page 12.
- The Design Management Server is installed as described in “Installing Design Management” on page 10.

Procedure
1. In the WebSphere Application Server administrative console, specify the following security settings:
   a. Turn off Java™ 2 security by clicking Security > Global security and clearing the Use Java 2 security to restrict application access to local resources check box.
   b. In the Current realm definition field, make sure that the proper security realm is configured and set as the current realm. Then, select the Enable administrative security and Enable application security check boxes.
   c. Click Security > Global security > Web and SIP security > General settings and select the Use available authentication data when an unprotected URI is accessed check box.
2. Specify the Java virtual machine settings for WebSphere Application Server:
   a. In the administrative console, click Servers > Server Types > WebSphere application servers and then click your server. By default, the server is named server1.
   d. In the Initial heap size field, specify 100.
   e. In the Maximum heap size field, specify the maximum memory for the server in MB. For 64-bit computers, specify an amount of memory that is appropriate to your environment, such as 4096 for 4GB of memory.
   f. In the Generic JVM arguments field, add -Xgcpolicy:gencon -Xmx1g -Xcompressedrefs -Xg:preferredHeapBase=0x100000000 -XX:MaxPermSize=128M -Xms8G -Xmx8G
   g. For Solaris operating systems only, in the Generic JVM arguments field, add -XX:MaxPermSize=384m. For more information about configuring a Solaris environment for WebSphere Application Server, see Chapter 2 of the IBM WebSphere Application Server V6.1 on the Solaris 10 Operating System redbook.
   h. Click Apply.
i. On the Java Virtual Machine page, under Additional Properties, click Custom Properties.

j. Click New and specify the JAZZ_HOME property, which identifies the location of configuration files for the Design Management Server, including the jts and dm folders. This property uses a URI rather than a simple file path, and it always begins with file:/// on a Windows system is as follows:
   file:///C:/PROGRA~1/IBM/JazzTeamServer/server/conf

   On a Linux system, the default location is as follows: file:///opt/ibm/JazzTeamServer/server/conf

   Note: To avoid problems, do not use spaces in file paths. For Program Files folders on 32-bit installations of Windows, you can use PROGRA~1, and for Program Files (x86) folders on 64-bit installations of Windows, you can use PROGRA~2.

k. Click New again and specify a property named log4j.configuration. Use the location of the startup_log4j.properties file as the value. This property uses the same format as the JAZZ_HOME property. In most cases, this file is in the JAZZ_HOME folder. The default value on a Windows system is as follows:
   file:///C:/PROGRA~1/IBM/JazzTeamServer/server/conf/startup_log4j.properties

   The default value on a Linux system is as follows: file:///opt/ibm/JazzTeamServer/server/conf/startup_log4j.properties

   Note: The settings in startup_log4j.properties are used at the early stages in the startup process to pass messages to the SystemOut.log file. After the early stages, each application switches to using the application-specific settings from the server/conf/<app_context>/log4j.properties file.

l. Click New again and specify a property named java.awt.headless with the value true.

m. Click New again and specify a property named org.eclipse.emf.ecore.plugin.EcorePlugin.doNotLoadResourcesPlugin with the value true.

n. If you are using a SQL Server database, click New again and specify a property named SQLSERVER_JDBC_DRIVER_FILE with the location of the file sqljdbc4.jar.

o. If you are using an Oracle database, click New again and specify a property named ORACLE_JDBC_DRIVER_FILE with the location of the file ojdbc5.jar.

   The custom properties look similar to the following figure. Note that some properties are present by default in addition to the properties that you add.

3. Save the changes to the master configuration and restart WebSphere Application Server.

   Now the server is ready to deploy the Design Management Server application files.

   Note: On a UNIX or Linux system, if WebSphere Application Server is installed in a non-root environment, the user who installs the Design Management Server must have read and write access to the installation directory and all its subdirectories.

4. Install the Jazz Team Server application:
a. In the administrative console, click **Applications > New Application > New Enterprise Application**. (For WebSphere Application Server 6.1, click **Applications > Install New Application**.)
b. Under **Path to the new application**, click **Browse** to specify the location of the `jts.war` file and click **Next**. If you did not install Apache Tomcat when you installed Design Management Server, the default location of this file is `installDir/server/webapps`. If you installed Tomcat, the default location is `installDir/server/tomcat/webapps`.
c. Under **How do you want to install the application?**, click **Fast Path** and then click **Next**.
d. On the Step 1: Select installation options page, accept the default options and click **Next**.
e. On the Step 2: Map modules to servers page, select the check box beside `jts.war`, ensure that the target server or cluster is correct, and click **Next**.
f. On the Step 3: Map virtual hosts for web modules page, select the check box beside `jts.war`, and click **Next**.
g. On the Step 4: Map context roots for Web modules page, set **Context Root** to `/jts` and click **Next**.
h. Click **Finish**.

5. Repeat the installation steps for the following war files and corresponding context roots:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dm.war</td>
<td>/dm</td>
</tr>
<tr>
<td>admin.war</td>
<td>/admin</td>
</tr>
<tr>
<td>vvc.war</td>
<td>/vvc</td>
</tr>
<tr>
<td>rdmhelp.war</td>
<td>/rdmhelp</td>
</tr>
<tr>
<td>clmhelp.war</td>
<td>/clmhelp</td>
</tr>
</tbody>
</table>

6. Map the security roles for the Jazz Team Server application to users and groups in your security realm. Setting up security is beyond the scope of this task, but in most cases in which your global security realm uses an LDAP registry, you map groups in the LDAP registry to the following security roles for the application:
   - JazzAdmins
   - JazzDWAdmins
   - JazzProjectAdmins
   - JazzGuests
   - JazzUsers
   a. Click **Applications > Application Types > WebSphere Enterprise Applications > jts_war**.
   b. Under **Detail Properties**, click **Security role to user/group mapping**. This page shows the user groups for the Design Management Server that you must map to users or groups in your security realm.
   c. Select a role and then click **Map Groups** to map that role to a group in your security realm.

   **Note**: Do not enable the **All authenticated?** option.

7. Verify that the applications installed successfully and then save the changes to the master configuration for WebSphere Application Server.
8. After saving to the master configuration, stop and restart the server.
9. In the WebSphere Application Server administrative console, click Applications > Application Types > WebSphere Enterprise Applications to confirm all applications are running.

Results

Green arrows appear beside the applications to indicate that they started correctly. The Enterprise Applications page looks like the following figure:

What to do next

Now you can configure the Design Management Server as described in “Setting up and configuring the Design Management Server” on page 24.

Setting up and configuring the Design Management Server by using express setup

Use the following steps to set up and configure the Design Management Server. After Design Management is installed, you must configure the Jazz Team Server URI as well as create an administrative user. The Express Setup configuration option uses the default Apache Derby database and creates the administrative user which is assigned to the data warehouses for each installed application.

Before you begin

Before you configure the server, you must enable pop-up windows to avoid installation problems during the setup and configuration process.

Important: When you set up and configure the model server, do not refresh the browser or use the front and back buttons.

Procedure

1. Start the installed server by using an account that has administrator permissions.
   • If you are using Apache Tomcat on a Windows operating system, click Start > All Programs > Collaborative Lifecycle Management > Start the Jazz Team Server.

   Important: If you are using Apache Tomcat, wait for the message INFO: Server startup in # ms. This step might take a while to complete the first time that you start the server; on subsequent restarts, the server starts much faster.

   Tip: To start the server from the command line, open a command prompt as an administrator: click Start > Programs > Accessories, right-click Command Prompt, and click Run as administrator. In the administrator command window, go to the server folder in your server installation directory and run server.startup.bat.

   • If you are using Apache Tomcat on a Linux operating system, go to the server folder in your server installation directory and run server.startup.

   • If you are using WebSphere Application Server, start the server from the WebSphere Application Server administrative console.
2. In a web browser, go to https://fully_qualified_host_name:9443/jts/setup.

A *fully_qualified_host_name* includes both the host name and the DNS domain reference of the server on which the Jazz Team Server is installed. An example of a fully qualified host name is myserver.example.org. The fully qualified host name cannot include localhost or an IP address.

To find the fully qualified host name (hostname.DNSsuffix) of the server on a Windows operating system, at a command prompt, type `hostname` to get the host name, and type `ipconfig` to get the DNS suffix.

On a Linux operating system, in a terminal window, type `hostname –fqdn`.

3. The Design Management Server is built on and runs on Jazz Team Server. Therefore, during the setup and configuration process, you must use parts of the standard Jazz Team Server functionality. On the Jazz Team Server login page, enter `ADMIN` (case sensitive) in both the User ID and Password fields, and then click Log In.

The following diagram displays the login page for the Jazz Team Server.

![Login Page](image)

4. On the Setup page, click Express Setup and click Next.

5. On the Configure Public URI page, provide a public URI in the following format: `https://fully_qualified_host_name:9443/jts`. After you read the warning, and if you understand the implications, click I understand that once the Public URI is set, it can not be modified. Design Management verifies the connection; after the test is successful, click Next.

The following diagram shows the Configure Public URI page. You can accept the default URI or enter a different URI.
Configure Public URI

The Public URI defines the root URL prefix for the URLs of all stored artifacts. This Jazz Team Server generates absolute URIs to resources used in stored artifacts, references between related artifacts, in mail notifications, feeds, for copying to the system clipboard, for Web access and for stable resource identification across all applications.

These generated URIs generally must be accessible from any network location from which a user or another application will be accessing the system. Once data is created and stored, these URLs will become persistent within the server. The server URL can be changed via administrative commands which preserve internal consistency, but this is a potentially disruptive action given it may not be possible to correct the stored links to the server from other applications and systems. Therefore it is important that you choose a public URI that is fully qualified, and likely to remain stable over time. For additional help, please see the Planning your URIs topic.

Configure this value in the following format: 'https://<public_hostname>:<port>/<context>' (e.g., https://host.mycompany.net:9443/jts)

Step 1: Configure Public URI

<table>
<thead>
<tr>
<th>Property</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public URI Root</td>
<td><a href="https://ottcsynk.ottawa.ibm.com:9443/jts">https://ottcsynk.ottawa.ibm.com:9443/jts</a></td>
</tr>
</tbody>
</table>

Step 2: Confirm Public URI

WARNING

The Public URI (which includes the fully qualified hostname) must be chosen carefully because once it is set, it becomes integral to the data on the server and any data on any other server or application that references it. This is particularly important when configuring a production server. Please review the information on this page and refer to the Planning your URIs topic for guidance and recommendations on configuring the Public URI.

- I understand that once the Public URI is set, it cannot be modified except with additional administrative commands, which can result in broken links from other applications that do not support changing URLs.

Tip: If another Jazz application is installed on the server, to avoid a port number collision, change the default port number from 9443 to an available port number. If you have a multiple or enterprise installation that is using Apache Tomcat and have different applications installed in different installations packages, each application must have a different port number to avoid collisions.

Remember: The variable `fully_qualified_host_name` is the host name and the DNS domain reference of the computer on which the Jazz Team Server is installed.

6. On the Create User page, create the user ID, name, password, and email address of the user who has administrative user access to the Jazz Team Server. You might consider using `DM_Admin` for the user ID, name, and password. This user has access to the data warehouse to run reports.
7. Click Next.
8. The application begins to configure and set up the database and data warehouse, register applications, install the sample project, and finalize each application. This process can take a few minutes. After the process is complete, click Next.
9. On the Assign Licenses page, assign the Rational Software Architect Design Manager - Design Manager or Rational Rhapsody Design Manager - Design Manager license to the new DM_Admin account, and then click Next.

   **Note:** If you are installing other CLM applications, you can also select licenses for Rational Requirements Composer, Rational Team Concert™, or Rational Quality Management. Click Activate Trial to get a temporary license.

10. Click Finish and the wizard redirects you to https://fully_qualified_host_name:9443/jts/admin.

**What to do next**

To help you get started, on the Server Administration page, click Create Users or Assign Client Licenses on the right side of the page under Task Guide.

### Setting up and configuring the Design Management Server

Use the following steps to set up and configure the Design Management Server. After Design Management is installed, you must configure the IBM Jazz Team Server URI and the database to store data. You must also configure the database, data warehouse, users, and other applications that you installed.

Before you configure the server, you must enable pop-up windows to avoid installation problems during the setup and configuration process.

**Important:** When you set up and configure the model server, do not refresh the browser or use the Forward and Back buttons in the browser.

To use a database other than the default Apache Derby database, see the following topics:

- “Setting up a DB2 database” on page 12
- “Setting up an Oracle database” on page 13
- “Setting up an SQL Server database” on page 15

If you want to use WebSphere Application Server instead of the included Apache Tomcat server, see the following topic:

- “Deploying the Design Management Server on WebSphere Application Server” on page 17

The first step of the setting up Design Management Server with the Rational solution for Collaborative Lifecycle Management (CLM) is to configure the IBM Jazz Team Server and its database.

1. Start the installed server by using an account that has administrator permissions.
   - If you are using Apache Tomcat on a Windows operating system, click Start > All Programs > Collaborative Lifecycle Management > Start the Jazz Team Server.
Important: If you are using Apache Tomcat, wait for the message INFO: Server startup in # ms. This step might take a while to complete the first time that you start the server; on subsequent restarts, the server starts much faster.

Tip: To start the server from the command line, open a command prompt as an administrator: click Start > Programs > Accessories, right-click Command Prompt, and click Run as administrator. In the administrator command window, go to the server folder in your server installation directory and run server.startup.bat.

- If you are using Apache Tomcat on a Linux operating system, go to the server folder in your server installation directory and run server.startup.
- If you are using WebSphere Application Server, start the server from the WebSphere Application Server administrative console.

2. In a web browser, go to https://fully_qualified_host_name:9443/jts/setup.

A fully_qualified_host_name includes both the host name and the DNS domain reference of the server on which the Jazz Team Server is installed. An example of a fully qualified host name is myserver.example.org. The fully qualified host name cannot include localhost or an IP address.

To find the fully qualified host name (hostname.DNSsuffix) of the server on a Windows operating system, at a command prompt, type hostname to get the host name, and type ipconfig to get the DNS suffix.

On a Linux operating system, in a terminal window, type hostname –fqdn.

3. If a security message is displayed, and you understand and accept the associated risks, configure your browser to connect to the server.

4. The Design Management Server is built on and runs on Jazz Team Server. Therefore, during the setup and configuration process, you must use parts of the standard Jazz Team Server functionality. On the Jazz Team Server login page, enter ADMIN (case sensitive) in both the User ID and Password fields, and then click Log In.

The following diagram displays the login page for the Jazz Team Server.
5. On the Setup page, click **Custom Setup** and click **Next**.

6. On the Introduction page, click **Next**.

7. On the Configure Public URI page, provide a public URI in the following format: `https://fully_qualified_host_name:9443/jts`. After you read the warning, and if you understand the implications, click **I understand that once the Public URI is set, it can not be modified.** Design Management verifies the connection; after the test is successful, click **Next**.

The following diagram shows the Configure Public URI page. You can accept the default URI or enter a different URI.
Configure Public URI

The Public URI defines the root URL prefix for the URLs of all stored artifacts. This Jazz Team Server generates absolute URIs to resources used in stored artifacts, references between related artifacts, in mail notifications, feeds, for copying to the system clipboard, for Web access and for stable resource identification across all applications.

These generated URIs generally must be accessible from any network location from which a user or another application will be accessing the system. Once data is created and stored, these URLs will become persistent within the server. The server URL can be changed via administrative commands which preserve internal consistency, but this is a potentially disruptive action given it may not be possible to correct the stored links to the server from other applications and systems. Therefore it is important that you choose a public URI that is fully qualified, and likely to remain stable over time. For additional help, please see the Planning your URIs topic.

Configure this value in the following format: "https://<public_hostname>:<port>/<context>" (e.g. https://host.mycompany.net:9443/jts)

### Step 1: Configure Public URI

<table>
<thead>
<tr>
<th>Property</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public URI Root</td>
<td><a href="https://notcspyhk.ottawa.ibm.com:9443/jts">https://notcspyhk.ottawa.ibm.com:9443/jts</a></td>
</tr>
</tbody>
</table>

### Step 2: Confirm Public URI

**WARNING**

The Public URI (which includes the fully qualified hostname) must be chosen carefully because once it is set, it becomes integral to the data on the server and any data on any other server or application that references it. This is particularly important when configuring a production server. Please review the information on this page and refer to the Planning your URIs topic for guidance and recommendations on configuring the Public URI.

- [ ] I understand that once the Public URI is set, it cannot be modified except with additional administrative commands, which can result in broken links from other applications that do not support changing URLs.

Tip: If another Jazz application is installed on the server, to avoid a port number collision, change the default port number from 9443 to an available port number. If you have a multiple or enterprise installation that is using Apache Tomcat and have different applications installed in different installations packages, each application must have a different port number to avoid collisions.

Remember: The variable `fully_qualified_host_name` is the host name and the DNS domain reference of the computer on which the Jazz Team Server is installed.

8. On the Configure Database page, complete the steps for the Jazz Team Server database that you are using.
Configure Database

By default, this Jazz Team Server includes a pre-configured database using a JDBC connection. You can either keep this default or choose a different database vendor and/or connection type. If you change the default, you may need to configure some additional properties. Also use the "Test Connection" button to verify that the Jazz Team Server can successfully communicate with the database using the connection information you provided.

Step 1: Configure Database Vendor and Connection Type

Database Vendor: Derby
Connection Type: JDBC

Step 2: Configure Database Connection Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDBC Password</td>
<td>Default Value: none</td>
</tr>
<tr>
<td>JDBC Location</td>
<td>conf/its/derby/repositoryDB</td>
</tr>
</tbody>
</table>

a. From the Database Vendor list, select the type of database.
b. From the Connection Type list, select JDBC.
c. In the JDBC Password field, specify the password for the database user that accesses the database.
d. In the JDBC Location field, specify the location of the database, using the phrase {password}, including the braces, in place of the actual password.
   • To install an Apache Derby database, leave the JDBC Password field blank and leave the default value in the JDBC Location field.
   • For a DB2 database, ensure that you prepared the necessary databases as described in "Setting up a DB2 database" on page 12 and then specify the connection string for the database. For example, if the database is installed on myserver.example.org on port 50001 and you are using the default db2inst1 user, specify the following JDBC location: //myserver.example.org:50001/JTS:user=db2inst1;password={password};
   • For an Oracle database, follow these steps:
     1) Create a folder named oracle in the server folder of the Design Management Server installation.
2) Put a copy of the Oracle JDBC JAR file ojdbc5.jar in the oracle folder.

3) Ensure that you have set up the database as described in "Setting up an Oracle database" on page 13 and then specify the connection string for the database. The following code is an example connection string:

```
thin:username/{password}@//myserver.example.org:1521/ORACLE_SID
```

Use the database user name for `username` and the ID of your Oracle system for `ORACLE_SID`.

\* For an SQL Server database, ensure that you set up the database as described in "Setting up an SQL Server database" on page 15, and then specify the connection string for the database. For example, if the database is installed on `myserver.example.org` and the instance name is `SQL_INSTANCE`, the location looks like the following example:

```
//<SQLServer host name>:1433;databaseName=Database Instance;user=<Database User>;password={password}
```

e. Click Next.

9. On the Enable E-mail Notification page, enable or disable email notification. If you enable notifications, you must provide information about the email server and test the connection. After your selection, click Next.

10. On the Register Applications page, accept the default settings and click Register Applications. The wizard detects the applications that are installed. The Jazz Team Server and Application Setup wizard automatically finds the Design Management (/dm), Configuration Management Server (/vvc) and Administration (/admin) application and, if applicable, any other CLM applications (/rm, /qm, and /ccm).

11. If you are setting up an enterprise or multiple installation scenario, you must provide the location of the other CLM and Design Management applications. Click Add Application and add the application instance and the URL of the server that contains the application. Then, click Register Applications.

12. After the application is registered, click Next. After the wizard registers applications, the left panel in the browser displays additional steps if you are installing multiple CLM applications.

13. On the Setup User Registry page, provide the following information.

   a. Select the type of user registry to use.

   Note: If you select an LDAP user registry, you must provide information to configure the connection between the Jazz Team Server and the LDAP server. You must log in to the WebSphere Application Server as a registered LDAP user with JazzAdmins privileges.

   b. Create the user ID, name, password, and email address of the user who has administrative user access to the Jazz Team Server. You might consider using `DM_Admin` for the user ID, name, and password.

   c. Optional: For security reasons, you can disable the ADMIN user.

   d. Assign the Rational Software Architect - Designer or Rational Rhapsody Design Manager - Design Manager license to the new `DM_Admin` account, and then click Next.

   Note: If you are installing other CLM applications, you can also select licenses for Rational Requirements Composer, Rational Team Concert, or Rational Quality Management. Click Activate Trial to get a temporary license.
14. On the Configure Data Warehouse page, specify the vendor and connection information for the data warehouse. You can also select the *I do not wish to configure the data warehouse at this time* check box to skip configuring the data warehouse.

The following diagram shows the Data Warehouse page. The Warehouse page is displayed multiple times if you are installing other CLM applications.

a. From the **Database Vendor** list, select the type of database.

b. From the **Connection Type** list, select **JDBC**.

c. In the **JDBC Password** field, specify the password for the database user that accesses the database.

d. In the **JDBC Location** field, specify the location of the database, using the phrase `{password}`, including the braces, in place of the password.

   - To install an Apache Derby database, leave the **JDBC Password** field blank and leave the default value in the **JDBC Location** field.

   - For a DB2 database, ensure that you have set up the database as described in "Setting up a DB2 database" on page 12 and then specify the connection string for the database. For example, if the database is installed on myserver.example.org on port 50001 and you are using the default db2inst1 user, specify the following JDBC location:

```
//myserver.example.org:50001/DW:user=db2inst1;password={password};
```

   - For an Oracle database, ensure that you set up the database as described in "Setting up an Oracle database" on page 13 and then specify the connection string for the database. The following code is an example connection string:

```
thin:username/{password}@//myserver.example.org:1521/ORACLE_SID
```

   Use the database user name for `username` and the ID of your Oracle system for `ORACLE_SID`.

   - For an SQL Server database, ensure that you set up the database as described in "Setting up an SQL Server database" on page 15, and then specify the location of the database. For example, if the database is installed on myserver.example.org and the database name is SQLdb, the location looks like the following example:

```
//myserver.example.org:1433;databaseName=SQLdb;user=<Database User>;password={password}
```

e. In the **Database Table Space Folder** field, specify where to create the table space. Do not use spaces in the location of the table space.

f. In the **Custom Report Database User** field, specify the name of the user that accesses the data warehouse for report information.

g. Click **Test Connection** and resolve any problems with the database connection before you continue.

h. At the bottom of the page, specify the login information for the user that runs data collection jobs for the data warehouse. If you are using an LDAP server or another external user registry, ensure that the registry has a matching user.

i. Click **Next**.

You have now completed the Jazz Team Server configuration. You can now configure the Design Management Server and any other CLM applications.
Setting up the CLM applications (optional)

If you are installing CLM applications along with Design Management Server, you must configure the CLM applications, including their databases and data warehouses.

For each CLM application configure the database and the data warehouse using the following steps.

1. On the Configure Database page, complete the steps for the IBM Jazz Team Server database that you are using:
   a. From the Database Vendor list, select the type of database.
   b. From the Connection Type list, select JDBC.
   c. In the JDBC Password field, specify the password for the database user that accesses the database.
   d. In the JDBC Location field, specify the location of the database, using the phrase {password}, including the braces, in place of the password.
      - To install an Apache Derby database, leave the JDBC Password field blank and leave the default value in the JDBC Location field.
      - For a DB2 database, ensure that you prepared the necessary databases as described in "Setting up a DB2 database" on page 12 and then specify the connection string for the database. For example, if the database is installed on myserver.example.org on port 50001 and you are using the default db2inst1 user, specify the following JDBC location: //myserver.example.org:50001/JTS:user=db2inst1;password={password};
      - For an Oracle database, follow these steps:
        1) Create a folder named oracle in the server folder of the Design Management Server installation.
        2) Put a copy of the Oracle JDBC JAR file ojdbc5.jar in the oracle folder.
        3) Ensure that you have set up the database as described in "Setting up an Oracle database" on page 13 and then specify the connection string for the database. The following code is an example connection string:
           thin:username/{password}@//myserver.example.org:1521/ORACLE_SID
           Use the database user name for username and the ID of your Oracle system for ORACLE_SID.
      - For an SQL Server database, ensure that you set up the database as described in "Setting up an SQL Server database" on page 15 and then specify the connection string for the database. For example, if the database is installed on myserver.example.org and the database name is SQLLdb, the location looks like the following example:
           //myserver.example.org:1433;databaseName=SQLLdb;user=<Database User>;password={password}
   e. Click Next.

2. On the Configure Data Warehouse page, specify the vendor and connection information for the data warehouse. You can also select the I do not wish to configure the data warehouse at this time check box to skip configuring the data warehouse.
   a. From the Database Vendor list, select the type of database.
   b. From the Connection Type list, select JDBC.
   c. In the JDBC Password field, specify the password for the database user that accesses the database.
d. In the **JDBC Location** field, specify the location of the database, using the phrase `{password}`, including the braces, in place of the password.
   - To install an Apache Derby database, leave the **JDBC Password** field blank and leave the default value in the **JDBC Location** field.
   - For a DB2 database, ensure that you set up the database as described in [“Setting up a DB2 database” on page 12](#) and then specify the connection string for the database. For example, if the database is installed on myserver.example.org on port 50001 and you are using the default db2inst1 user, specify the following JDBC location:
     
     
     ```
     /myserver.example.org:50001/DW:user=db2inst1;password={password};
     ```
   - For an Oracle database, ensure that you set up the database as described in [“Setting up an Oracle database” on page 13](#) and then specify the connection string for the database. The following code is an example connection string:
     
     ```
     thin:username/{password}@//myserver.example.org:1521/ORACLE_SID
     ```
     Use the database user name for `username` and the ID of your Oracle system for `ORACLE_SID`.
   - For an SQL Server database, ensure that you set up the database as described in [“Setting up an SQL Server database” on page 15](#) and then specify the location of the database. For example, if the database is installed on myserver.example.org and the database name is SQLdb, the location looks like the following example:
     
     ```
     //myserver.example.org:1433;databaseName=SQLdb;user=<Database User>;password={password}
     ```

e. In the **Database Table Space Folder** field, specify where to create the table space. Do not use spaces in the location of the table space.

f. In the **Custom Report Database User** field, specify the name of the user that accesses the data warehouse for report information.

g. Click **Test Connection** and resolve any problems with the database connection before you continue.

h. At the bottom of the page, specify the login information for the user that runs data collection jobs for the data warehouse. If you are using an LDAP server or another external user registry, ensure that the registry has a matching user.

i. Click **Next**.

3. Click **Finalize Application Setup** for each CLM application.
   The Finalize Application page is displayed for most CLM applications but can differ depending on the application. Some steps can take a few minutes to complete.

You have configured the CLM applications. You can now configure the Design Management Server by completing similar steps.

### Configuring the Design Management application

You can now set up the Design Management application. The set up is similar to the set up for CLM applications, but includes additional steps for Design Management functionality.

1. On the Design Management Configure Database page, complete step 8 from the previous procedure.
2. On the Jazz Applications Framework (JAF) Finalization Application page, under Step 1, click **Finalize Application Setup**. After the application is finalized, click **Next**.

3. On the Finalize Application page, click **Finalize Application**. Once completed, click **Next**. Note that steps 6 and 7 on the **Finalize Application** page can take up to 15 minutes to complete.

   In the following diagram, the Finalize Application page is displayed for Design Management. Each step can take a few minutes to complete.

You have successfully installed the Design Management application. You can now set up the remaining the CLM applications for requirements management and lifecycle project administration.

### Setting up quality management and requirements management and lifecycle project administration applications

If applicable, you can now set up the CLM applications for requirements management and lifecycle project administration.

These applications use the same database as IBM Jazz Team Server. As a result, the database steps are not available on the menu for these applications.

1. For quality management applications, you must complete similar steps under the heading **Setting up the CLM applications**.
2. Click **Finalize Application Setup** for each application.

### Summary

1. On the Summary page, review the setup details for the Jazz Team Server.
   
   **Important**: At this point in the wizard, you have successfully completed the setup and the application is ready to use.

2. Click **Finish** and the wizard redirects you to https://fully_qualified_host_name:9443/jts/admin.

### Installation summary

You have completed the setup of the Design Management Server.

To help you get started, on the Server Administration page, click **Create Users** or **Assign Client Licenses** on the right side of the page under **Task Guide**.

### Adding domain extension servers to host Rational Software Architect content

*This content applies to version 4.0.3 or later.* You can add a dedicated domain extension server to ensure that the Design Management Server displays Rational Software Architect content such as diagrams, data from the Explorer view, import functionality, and properties. The extension server is a separate installation package that you can install with the Design Management Server. You can also install the server by itself on a separate server and register it manually.
About this task

You can add extension servers separately and register them on the Design Management Server administration pages. If the extension server is installed and started when the Design Management Server setup begins, the setup process discovers the server and automatically adds it to the administration page. If an extension server is not installed, the setup wizard warns you that the steps below are necessary.

Tip: When you add a new Design Management Domain Extension Server, ensure that the computer that hosts the Design Management Server can communicate with the computer that hosts the extension server. If you experience problems, such as diagrams not loading, you might need to add a firewall exception so that the servers can communicate.

Procedure
1. In the upper-left corner of the page, click the Home icon; then click Jazz Team Server Home.
2. On the Server Administration page, scroll to Application Administration and, under Design Management, click Manage All Project Areas.
3. On the Design Management Administration page, on the main menu bar, click Domain Extension Servers.
4. To add a new server to display Rational Software Architect diagrams, in the upper-right corner of the page, click Add New Server.
5. In the New Domain Extension Server window, enter a server name and enter a URL in this format: https://host:port/rsadm. To use the server immediately, click Enabled.

Important: If you enter an extension server URL that does not exist, UML-based diagrams will not appear in the diagram editor even if you clicked Enabled. If a message in the diagram editor states Unable to load diagram, check the dm.log file for information about how to resolve the problem.
6. Click OK.

Changing the public URL using server rename

You can change the public URL for a Jazz Team Server by using the server rename capabilities.

About this task

The process for changing the public URL of the Jazz Team Server that hosts Design Management Server is identical to the process that is provided in the Rational solution for Collaborative Lifecycle Management 4.0 Information Center.

When you install Design Management Server with Collaborative Lifecycle Management, if you rename the Jazz Team Server using a mapping file, you must include the design management application in the mapping file, just like any other application.

Use the related links below to learn how to change the public URL and to learn more about mapping files used in the server rename process.
Carefully consider clients that rely on the server to be renamed. To prevent any
disruption and to preserve availability, notify end users of those clients in advance
that you are going to change the URLs of the servers used by those
clients. Encourage end users to perform backups and to complete tasks in
progress, such as code deliveries, before you start the rename procedure.

**Important:** To enable the server rename capabilities, you must obtain a feature key
file from IBM Software Support. Renaming a server is a complex and potentially
disruptive operation because correcting the stored links to the server from other
applications and systems can be difficult or impossible. Renaming a server is
supported only for a limited set of scenarios, and it requires careful planning.
Rename a server only when other approaches are not possible. When you contact
IBM Software Support, state that you are requesting a "server rename feature key
file."

**Related information:**

- Changing the public URL using server rename
- Planning for server rename
- Mapping file for server rename
- Completing the Design Management server rename verification process
- Deployment wiki and community

### Installing optional tools, client extensions, and samples

Once you install Design Management Server, consider installing the following
optional tools, client extensions, and samples.

#### Installing Rational Software Architect components

Install the following components to work with Rational Software Architect models
in Design Management Server.

#### Installing the sample project

The sample project provides an example of how you can install a project in Design
Management Server that is populated with Rational Software Architect models.

**Before you begin**

You must install and start the Design Management Server. See "Installing Design
Management" on page 10.

**About this task**

The Design Management Server comes with a sample project that you can use to
experiment with different settings. The sample project contains a sample project
area but no sample models; if you want a sample model, you can get one from the
Design Management downloads page at Jazz.net. If you do not install the sample
project, you can create a project later by completing the following steps:
Procedure
1. In a web browser, go to the following address: https://
   serverLocation:portNumber/dm/admin. For serverLocation, use the fully qualified
   location of your server. For portNumber, use the port on which the Design
   Management Server is running.
2. Log in as an administrator.
3. On the menu tab, click **Rational Software Architect Sample**.
4. On the Welcome to the Rational Software Architect Design Management
   Sample page, click **Create Sample Project** and then click **Next**.

What to do next
The sample project is created. You can view the progress by clicking the **Import
Status** link or to view the sample, click the **Welcome to Designs** link.

Installing the Rational Software Architect Design Manager Import
Engine
Install the Rational Software Architect Design Manager Import Engine to import
Rational Software Architect models to the model server.

Procedure
1. Log on to your computer or local area server as a user with administrator
   permissions.
2. Go to the RSADM_Setup or RSADM/disk1 directory and run the launchpad file.
   - **Windows** Run launchpad.exe.
   - **Linux** Run launchpad.sh.
3. In the launchpad, under **IBM Rational Software Architect Design Manager
   Import Engine**, click **Install the import engine**. IBM Installation Manager
   opens and lists the available software, including the components of Rational
   Software Architect Design Manager Import Engine and the version of
   Installation Manager that installs them.
4. In IBM Installation Manager, select the check boxes to install the import
   engine.
5. After you select the software to install, click **Next**.
6. For each component that you install, you must review and accept the license
   agreement and click **Next**.
7. Accept the default installation directory, or enter a different location; then click
   **Next**.
8. Select the languages to install, and click **Next**.
9. Review the summary information, and click **Install**.
10. Click **Install**.
11. To complete the installation and close IBM Installation Manager, click **Finish**.
12. Close the launchpad.

What to do next
Now you can configure the import engine as described in **Configuring the import
engine** on page 46.
Installing a trial of Rational Software Architect

If you do not have Rational Software Architect, but want to explore the Design Management Server capabilities in the product, you can download a trial version to evaluate. After you download and install Rational Software Architect, you can install the client extension to connect to the Design Management Server from Rational Software Architect.

About this task


Note: You can also install the client extension into versions 8.0.1 or greater of Rational Software Architect.

Installing the Rational Software Architect Extension for Design Management

You can install the Rational Software Architect Extension for Design Management to access the search, commenting, markup, and other services that the Design Management Server supports in Rational Software Architect. This extension adds a Team Modeling view, a Comments view, and provides additional fields that allow you to search a model repository on the Design Management Server. You can install the Rational Software Architect Extension for Design Management on multiple computers that have Rational Software Architect (version 8.0.4.1 and later, or version 8.5 and later) installed.

Procedure

1. Log on to your computer or local area server as a user with administrator permissions.
2. Go to the RSADM_Setup or RSADM/disk1 directory and run the launchpad file.
   - **Windows** Run launchpad.exe.
   - **Linux** Run launchpad.sh.
3. In the launchpad, under IBM Rational Software Architect Extension for Design Management, click Install Client. IBM Installation Manager opens and lists the client extension component package. You can also install the IBM Rational Software Architect Extension for Design Management directly in IBM Installation Manager by using a repository.
4. Click Next.
   a. If you agree to the license agreement, click I accept the terms in the license agreements and then click Next.
   b. On the Install Packages page, accept the default directory and then click Next. The directory must be the same as the installed Rational(r) Software Architect package which the Installation Manager will locate automatically.
   c. On the features to install page, click Next.
   d. Click Install

Configuring the Rational Software Architect Extension for Design Management

If you want to work in Rational Software Architect with resources that are located on a Design Management Server, you must configure the Rational Software Architect Extension for Design Management.
About this task

After you install the Rational Software Architect Extension for Design Management, you must update Rational Software Architect with the location of the Design Management Server; otherwise, you cannot synchronize comments made between models in Rational Software Architect and models that were imported onto the server.

Note: When you establish a connection between a Rational Software Architect workspace and a model repository on the Design Management Server, any changes that you make in your workspace do not update automatically on the Design Management Server. To make workspace changes available on the server (for example, if you add an operation to a class), you must import the model contents onto the server. However, if you add any links, comments, or sketches to a resource, these lightweight updates are updated on the server instantly.

Procedure

1. In Rational Software Architect, to open the Design Explorer view, click Window > Show View > Other; then click Modeling > Design Explorer and click OK. This view opens beside the Project Explorer view.
2. In the Design Explorer view, right-click Create a new connection. The Server Configuration window opens.
3. In the Address field, enter the address of the server, such as https://fully_qualified_host_name:9443/dm.
4. In the Name field, instead of using the default server name, you might want to rename the server to something more meaningful to your project.
5. In the Username and password fields, enter the same user name that you use to log in to the Design Management Server.
6. Click OK.

Installing Rational Rhapsody components

Install the following components to work with Rational Rhapsody in Design Management Server.

Installing the sample project

The sample project provides a project on the Design Management Server for a sample model from Rational Rhapsody. After you create the project, members of your team can comment on the model.

Before you begin

You must install and start the Design Management Server. See “Installing Design Management” on page 10.

About this task

The Design Management Server comes with a sample project that you can use to experiment with different settings. The project contains a sample model:

Procedure

1. In a web browser, go to the following address: https://
   serverLocation:portNumber/dm/admin. For serverLocation, use the fully qualified location of your server. For portNumber, use the port on which the Design Management Server is running.
2. Log in as an administrator.
3. On the menu tab, click **Rational Rhapsody Sample**.
4. On the Welcome to the Rational Rhapsody Design Management Sample page, click **Create Sample Project** and then click **Next**.

**What to do next**

The sample project is created and the Rational Rhapsody automated meter reader model is imported into the sample project. You can view the sample by clicking the view **Project Dashboard** link.

---

## Installing the Rational Rhapsody Design Manager Import Engine

You can install the Rational Rhapsody Design Manager Import Engine to import Rational Rhapsody models to the Design Management Server. The import engine can be installed on any computer on which you are storing models that you want to import onto the server.

**Procedure**

1. Open the RhapsodyDM_All/disk1 directory and run the launchpad file.
   - **Windows**: Run launchpad.exe.
   - **Linux**: Run launchpad.sh.
2. In the launchpad, under **IBM Rational Rhapsody Design Manager Import Engine**, click **Install the import engine**.
3. Clear all check boxes, but leave **Rational Rhapsody Design Manager Import Engine** selected.
4. On the Install Packages page, click **Next**; if you agree to the license agreement, click **I accept the terms in the license agreements** and then click **Next**.
5. On the Install Packages page, accept the default installation directory, or enter a different location and click **Next**.
6. Click **Next** until the **Install** push button is active; then click **Install**.
7. To complete the installation, click **Finish**.
8. Close the launchpad.

**What to do next**

Configure the Rational Rhapsody Design Manager Import Engine. Before you can collaborate on models with your team, you need to install the Rational Rhapsody Design Manager Client Extension.

**Related tasks:**

- “Configuring the Rational Rhapsody Design Manager Import Engine” on page 54
- “Installing the Rational Rhapsody Design Manager Client Extension” on page 40

## Installing the Rational Rhapsody Simulink Manual Importer

You can install the Simulink Manual Importer on computers that have MathWorks Simulink installed already. Then you can import Simulink models on to the Design Management Server so that designers and project stakeholders can publish and collaborate on MathWorks Simulink models.
Procedure

1. Log on to your computer or local area server as a user with administrator permissions.
2. Go to the RDM_Setup directory and run the launchpad file.
   - On Windows, the file is launchpad.exe.
   - In Linux, the file is launchpad.sh.
4. Click **Next**.
   a. If you agree to the license agreement, click **I accept the terms in the license agreements**, and then click **Next**.
   b. On the Select the program features you want installed page, select IBM Rational Rhapsody Simulink Manual Importer.
   c. On the Destination Folder page, accept the default installation folder, and then click **Next**.
   d. Click **Install**.
   e. On the InstallShield Wizard Completed page, select the check box to open the instructions for the importer. Access to the Internet is required to be able to access the link.
5. Click **Finish**

Installing a trial of Rational Rhapsody, version 8.0

If you do not have Rational Rhapsody, but you want to explore the Design Management Server capabilities in Rational Rhapsody, you can download a trial version. After you download and install Rational Rhapsody, version 8.0, you can connect to the Design Management Server from Rational Rhapsody.

About this task


Installing the Rational Rhapsody Design Manager Client Extension

Use this procedure to install the IBM Rational Rhapsody Design Manager Client Extension. The Rational Rhapsody Design Manager Client Extension extends the Rational Rhapsody application to support connecting with the Rational Rhapsody Design Management Server.

Before you begin

You must install Rational Rhapsody version 8.0 on the same computer before you install the Rational Rhapsody Design Manager Client Extension.

About this task

You can install the Rational Rhapsody Design Manager Client Extension to access the search, commenting, markup, and other services that the Rational Rhapsody Design Manager supports in Rational Rhapsody. This extension adds views for OSLC linking, commenting, collaborating, and change sets. The extension also provides additional fields that allow you to search a model repository on the Rational Rhapsody Design Manager.
Procedure

1. Log on to your computer or local area server as a user with administrator permissions.

2. Go to the RhapsodyDM_All/disk1 directory and run the launchpad file.
   - On Windows, the file is launchpad.exe.
   - In Linux, the file is launchpad.sh.

3. In the launchpad, under IBM Rational Rhapsody Design Manager Client Extension, click Install Client. IBM Installation Manager opens and lists the client extension component package.

4. Click Next.
   a. If you agree to the license agreement, click I accept the terms in the license agreements, and then click Next.
   b. On the Select the program features you want installed page, select Rational Rhapsody Design Manager Client Extension.
   c. On the Destination Folder page, accept the default installation folder, and then click Next.
   d. Click Install.
   e. On the InstallShield Wizard Completed page:

5. Click Finish.

Installing the Rational Rhapsody Design Manager Client Extension for the Rational Rhapsody in Eclipse client

You can install the IBM Rational Rhapsody Design Manager Client Extension so that you can use it with Rational Rhapsody in an Eclipse working environment on a Windows system.

Before you begin

Install the following products before you link Rational Rhapsody to the Eclipse client.

- Eclipse, version 3.5.2 or higher.
- The Rational Rhapsody Design Manager Client Extension and the prerequisite products for it for the Rational Rhapsody, version 8.0.
- Internet Explorer, version 8 or higher.

Procedure

1. Open Eclipse and select Help > Install New Software.

2. On the Available Software page, add the Rhapsody In Eclipse Update Site: Click Add and browse to <Rational Rhapsody installation path>Eclipse.

3. Select the IBM Rational Rhapsody Platform Integration check box, and then click Next.

4. Continue and complete the linking of Rational Rhapsody to Eclipse, and click Finish.

5. Restart Eclipse and verify that you have installed the Rational Rhapsody in Eclipse client: Be sure that you are able to switch to the Rhapsody Modeling perspective.

6. To install the Rational Rhapsody Design Manager Client Extension for the Rational Rhapsody in Eclipse client, open Eclipse and select Help > Install New Software.
7. On the Available Software page, add the RDM Eclipse Client Extension Update Site. Click Add and browse to `<Rational Rhapsody installation path>\DesignManager\Eclipse`. The DesignManager folder was installed during the Windows installation.

8. Select the **IBM Rational Rhapsody in Eclipse Design Manager Client Extension** check box, and then click Next.

9. To continue with the installation, you must accept the license agreement, and then click Next.

10. Continue and complete the installation, and then click Finish.

11. Verify that the Rational Rhapsody Design Manager Client Extension is installed for your Rational Rhapsody in Eclipse client:
    a. Open Eclipse and select **Window > Show View > Other**.
    b. Verify that the Rhapsody group has the following views:
       - DM Collaboration View
       - DM Reviews View
       - DM Search View
       - DM Links View
       - DM Changeset View

**Installing the Rational Rhapsody Design Manager Client Extension for the Rational Rhapsody client on a Linux system**

You can install the IBM Rational Rhapsody Design Manager Client Extension for the IBM Rational Rhapsody client on a Linux system.

**Before you begin**

Install the following products before you install the Rational Rhapsody Design Manager Client Extension.

- The IBM Rational Rhapsody client, version 7.6 or higher. See [Installing Rational Rhapsody Developer on a Linux system](#).
- Mozilla Firefox, version 3.6 or higher. Be sure that this browser is available in your environment variable path.

**Procedure**

1. When you download the Design Manager Server for Rational Rhapsody, it includes the installation for the Client Extension. Run the Rational Rhapsody Design Manager Linux Client Extension installation script located in `<installation folder>/DM_Client/INSTALL`. For an example of how to run an installation script in Linux, see [Installing Rational Rhapsody Developer on a Linux system](#).

2. Confirm that you have the Rational Rhapsody Design Manager Client Extension installed for your Rational Rhapsody client:
   a. Start the Rational Rhapsody client.
   b. Open your model.
   c. Expand the **Tools** menu and see that the **Design Manager** menu is now available and has options for **Collaboration View**, **Reviews View**, and **Search View**.
   d. Right-click your model in the Rational Rhapsody browser and see that you now have an **Open in Design Manager** option.
What to do next

You are ready to connect to the Design Manager Server with your Rational Rhapsody client, see "Configuring the Rational Rhapsody Design Manager Client Extension."

Configuring the Rational Rhapsody Design Manager Client Extension

If you want to work in Rational Rhapsody with resources that are located on a Design Management Server, you must configure the Rational Rhapsody Design Manager Client Extension.

About this task

You must update Rational Rhapsody with the location of the Design Management Server; otherwise, you cannot synchronize comments made between models in Rational Rhapsody and models that were imported onto the server. When you establish a connection between a Rational Rhapsody workspace and a model repository on the Design Management Server, any changes that you make in your workspace do not update automatically on the Design Management Server. To make workspace changes available on the server (for example, if you add an operation to a class), you must import the model contents onto the server. However, if you add any links, comments, or sketches on a resource, these lightweight updates are updated on the server instantly.

Note: If you are using Rational Rhapsody version 8.0 and you are connecting to an actively managed project area on the Design Management Server, you do not need to complete the steps in this task.

Procedure

1. In Rational Rhapsody, click View > Collaborative View; then click Modeling. This view opens a new window next to the Output window.
2. In the New Server URL field, enter the address of the server, such as https://fully_qualified_host_name:9443/dm
3. In the Name field, instead of using the default server name, you might want to rename the server to something more meaningful to your project.
4. In the Username and password fields, enter the same user name that you use to log in to the Design Management Server.
5. Click OK.
Chapter 3. Sharing Rational Software Architect models

Before you can view Rational Software Architect models and diagrams on the web, you must import model data to the Design Management Server by using the Rational Software Architect Design Manager Import Engine.

About this task

Importing model data is not a one-time action; you must reimport model data each time that you want changes in your local workspace to be visible on the Design Management Server. You can also schedule import operations so that they occur on a regular basis automatically. In addition, you can write Ant scripts to pull model content directly from your source control management system onto the Design Management Server.

You can also import models directly from the Rational Software Architect Extension for Design Management.

Related concepts:
“Rational Software Architect Design Manager Import Engine”

Related reference:
“Ant scripts for pulling model content onto the Design Management Server” on page 50
“Troubleshooting the Rational Software Architect Design Manager Import Engine” on page 51

Related information:
Upload a model to the Design Management server
Importing Rational Software Architect models NullPointerException Technote

Rational Software Architect Design Manager Import Engine

The Rational Software Architect Design Manager Import Engine is a small application that can run on any computer on the network, but the engine is typically set up on a computer that can serve model data; that is, which can check out data from a configuration management system.

You use the import engine to place model content on the Design Management Server, index it, and make it generally available through the API of the Design Management Server and web interface. The import engine reads the model content from the files, compresses them, and sends them to the Design Management Server; the import service on the Design Management Server checks to see if any of the resources on the server needs to be modified. Each import engine instance is identified by a simple text identifier; this identifier is usually associated with a particular project, and represents an import definition that the engine is able to provide. This simple text identifier can span a file system with model content from multiple projects.

Ensure that you place Rational Software Architect Design Manager Import Engines on computers that have efficient access to authoritative sources, such as a software configuration management system or shared network locations.
In a simple configuration, which is appropriate for low volume servers, the import engine can be on the same computer as the Design Management Server. You can also configure the import definition to run an Ant script before gathering the file content. This script can invoke a checkout in a source control repository to update the local file system with the latest content, or validate the content or state of the project before sending it to the Design Management Server.

The Design Management Server operates in a pull mode, not a push mode, which means that the server controls the flow of data. Instead of individual content suppliers pushing new and updated content to the server, the Design Management Server retrieves updates when it is ready to accept content.

Import engines poll the server periodically and query whether it is ready for updated content. If the Design Management Server is ready for updated content, the server sends a manifest of the content that it currently has, and the import engine searches the file system for changes by comparing file names and time stamps. Therefore, the import engine sends the server only updated content. When the Design Management Server receives the updated content, it processes the information and makes that content available.

Related tasks:
Chapter 3, “Sharing Rational Software Architect models,” on page 45

Related reference:
“Ant scripts for pulling model content onto the Design Management Server” on page 50
“Troubleshooting the Rational Software Architect Design Manager Import Engine” on page 51

Related information:
Upload a model to the Design Management server
Importing Rational Software Architect models

Configuring the import engine

Before you start the import engine, you must set it up correctly. Configuring the import engine typically occurs once for each computer. For example, if your team has five separate computers that contain model content for the Design Management Server, your team must configure the import engine on each of the individual computers.

Before you begin

Before you configure the import engine, you must ensure that the Jazz Team Server to which to import the models is started. To start the server, click Start > All Programs > Design Management > Start the Jazz Team Server and CLM applications. In the Tomcat command window, wait for this message: INFO: Server startup in # ms. This step might take a while to complete the first time that you start the server; however, on subsequent instances, the server starts faster.

Before you import a model, you must create and define a configuration space. A configuration space is a group of configurations (a unique set of versions). Each design management project area is associated with a configuration space; multiple project areas can be related to the same configuration space and can share configurations.
Procedure

1. Click Start > Programs > Rational Software Architect Design Manager Import Engine > Configure import engine.

2. In the import engine, in the Front Server URL field, enter the fully qualified host name of the Design Management Server server URL, such as https://[fully_qualified_hostname]:9443/dm. The front server URL must point to the computer that hosts the imported model content.

3. Specify the Jazz user account and Jazz user password. You might consider creating an administrator or functional user who is responsible for placing model content on the server.

   **Note:** The Jazz user ID and password can be for any user account that has at least guest permissions.

4. In the Import Engine Name field, enter a name, such as DM_Import_Def that symbolically represents the computer on which the import engine runs; many import definitions can use the same import engine name. All import engine names are case sensitive. You need the import engine name when you import model content to the Design Management Server.

5. In the Eclipse Installation Directory field, ensure that the directory path points to the default installation directory for the import engine: C:/Program Files/IBM/RSADMImportEngine. In the default installation directory, you can import workspaces from standard Eclipse installations; that is, Eclipse installations that use CVS or no source control management system. However, if you have model content that resides in a Rational Team Concert workspace, or in a workspace that is connected to any other software configuration management (SCM) system that requires support beyond standard Eclipse, you must specify a value in the Eclipse Installation Directory field that points to the location of the Rational Team Concert Eclipse client installation or the installation directory of the SCM system.

   **Important:** If your workspace has multiple projects that contain modeling elements, and a subset of those projects reside under Rational Team Concert source control, you must ensure that the Eclipse Installation Directory field points to the installation location of Rational Software Architect with Rational Team Concert. Otherwise, if you specify the default location of the import engine, after the import process, you can only view model content that is not under source control. Rational Team Concert stores projects in a way that standard Eclipse cannot discover.

6. Ensure that Design Management Server is running, and test the configuration by clicking Test Configuration. The test and configuration might take several minutes to complete.

7. Click OK. The import engine starts, and an icon for the import engine is added to the system tray.

Results

After you configure the import engine, it starts automatically. The import engine is a background process that runs until you stop it. To start the import engine, click Start > Rational Software Architect Design Manager Import Engine > Start import engine. The Start menu also contains an option to stop the import engine.

You can also start and stop the import engine from the system tray icon: click the icon and use the pop-up menu to start, stop, reconfigure, or exit the import engine.
Creating import definitions for Design Management Server

After you configure and start the IBM Rational Software Architect Design Manager Import Engine, you must create an import definition on the Design Management Server that specifies all the model content to import to the server.

Before you begin

Important: Before you import a model, you must create and define a configuration space. A configuration space is a group of configurations (a unique set of versions). Each design management project area is associated with a configuration space; multiple project areas can be related to the same configuration space and can share configurations.

About this task

You can define the model content to place on the Design Management Server in two ways:

- **Import an entire workspace**: This mode uses an installed version of Eclipse to access the workspace. With this option, you can perform an exact one-to-one mapping or import of the local workspace; every model in the workspace is placed on the model server. This option places all content on the model server quickly.

- **Import individual projects**: This mode uses the file system and does not require an Eclipse installation unless you want to use Ant scripts. With this option, you can customize and define individual projects to place on the model server. Using this option, you can pull projects from different Eclipse workspaces; you can also pull specific projects from the same Eclipse workspace, rather than all content, when you use the first option.

In addition, Eclipse workspaces may contain linked projects that are not physically located under the root workspace folder. In order to support selective import of these projects, the Import Engine tries to detect if a specified workspace folder is located in an Eclipse workspace that contains a `.metadata` folder (located under specified root workspace folder). If so, the import engine tries to load the workspace, and then finds and imports the selected projects. If this attempt is not successful (for example, if at least one project is missing after workspace was loaded), the import engine tries to find the missing project by using file system.

Important: After an import definition is created, you cannot change the mode until the import definition is deleted. To delete an import definition, on the Import Definition page, click **Delete Import Definition and Data**; the import definition, including all previously imported models, are deleted.

Note: To access the Import Definition page, click the File menu at the top of the screen, and click **Import Definition**.

Procedure

1. To create an import definition by specifying an Eclipse workspace path, click **File > Import Definition**. A project area should be loaded, and a configuration (space) should be specified.

   Note: You cannot import a model into a project area that is actively managed with Design Management.
2. On the Import Definition page, click an import option, and complete the substeps for the option:

- **Import an entire workspace**
  a. In the **Import Engine Name** field, enter the same import engine ID that you created when you configured the import engine: DM_Import_Def.
  b. Click **Test** to ensure the import engine started and that the connection is valid.
  c. (Optional) In the **Ant Script Path** field, enter the location of the Ant script.
  d. In the **Eclipse Workspace Path** field, enter the path to your local Eclipse workspace folder that contains the model content to import to the Design Management Server. The Eclipse workspace path should point to a local computer (not to the Design Management Server) that contains the Rational Software Architect models; this computer must also have the import engine installed, configured, and running. When you provide this file path, you are configuring the import engine to go to a specific workspace and put all the model contents into a project on the Design Management Server.
  e. (Optional) In the **Path Maps** section, specify the path map variables that you use in your workspace. Remember, the Design Management Server has no file system, so the value of a path map must be relative to the workspace path.

- **Import individual projects** from one or more Eclipse workspaces. This mode uses the file system and does not require an Eclipse installation unless you want to use Ant scripts.
  a. In the **Import Engine** field, enter the same import engine ID that you created when you configured the import engine: DM_Import_Def.
  b. Click **Test** to ensure the import engine started and that the connection is valid.
  c. (Optional) In the **Ant Script Path** field, enter the location of the Ant script.
  d. Under **Projects**, enter the paths to the individual projects in Eclipse workspaces on the computer that contains the model content to import. To add a project, in the Projects section, click **Add**.
  e. Enter the names of the projects to import.
  f. (Optional) In the **Path Maps** section, specify the path map variables that you use in your workspace. The server has no file system, so the value of a path map must be relative to the workspace path.
  g. (Optional) In the **Advanced** section, specify the number of minutes for the import engine to wait before the engine stops trying to transfer model content.

3. (Optional) In the Schedule section, click **Automatically request an import using this schedule** and specify how often the import engine checks for model updates. You can also schedule a snapshot after the import process so that you have a view of the project at a specific point in time.

4. To retain all the import definition updates, click **Save**.

---

**Requesting import operations for Design Management Server**

After you create an import definition, you can request an import operation to load Rational Software Architect model content onto the Design Management Server.
About this task

Note: You cannot import a model into a project area that is actively managed with Design Management.

Procedure
1. On the Request Import Definition page, under File, click Request Import.
2. Select any of the following check boxes:
   - **Reimport and overwrite all resources**: Starts the entire import process again, which can take a long time to complete. If you clear this check box, only model resources that changed are imported onto the model server.
   - **Create snapshot of the entire project after import completed**: Creates a snapshot after the import process so that you have a view of the project at a specific point in time.
3. Click Request Import. The import process begins, and the status page loads. You can hover over the running process to see an update of how the import process is progressing. When the import process completes, you can view the number of resources and elements in the report, as well as other important statistics that relate to the import process.

   **Important**: The import process can take a long time to complete based on the size of the model content that you are importing onto the Design Management Server. Small models are quick, but model content that is very large might take hours to complete.

Ant scripts for pulling model content onto the Design Management Server

You can use Ant scripts to connect to your configuration management system with the Design Management Server.

You can use custom Ant scripts to pull the latest versions of model data onto the file system of the computer from which the Design Management Server retrieves data. In the web UI, you can use the Import Definition page to specify where the Design Management Server retrieves the model data by using the Eclipse workspace path or the workspace path and project directories. These paths must point to the file system of the same computer on which the import engine is installed and configured.

**Important**: This process requires knowledge of Ant and how to write custom scripts for your configuration and environment.

To use an Ant script to retrieve the latest model data from your configuration management system, you must complete the fields that relate to the Design Management Server.
<table>
<thead>
<tr>
<th>Design Management Server field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ant Script Path</strong> Location: In the web UI, on the Import Definition page</td>
<td>This path points to the location of the Ant script. The location must be on the same file system as the computer on which the import engine is installed. For example, an Ant script might perform a task such as using specific credentials to log into the source control management (SCM) server, locate the projects in the workspace, and retrieve the latest data. You can also write Ant scripts to perform other tasks; however, at this time, Ant is not required for anything other than pulling model data from the SCM system. <strong>Note:</strong> You can write an Ant script that does not require knowledge of workspaces. When you add an Ant script path to the import definition, the Ant script runs as the first step in the import process.</td>
</tr>
<tr>
<td><strong>Eclipse Installation Directory</strong> Location: In the Import Engine Configuration window</td>
<td>This field must point to an Eclipse installation that can interpret the Ant script in the import definition. If you did not provide an Ant script, leave the value of this field as the default value, which points to the installation location of the import engine. Although the import engine is not a true Eclipse installation, but is a rich client platform, it can manage the import process when an Ant script is not required.</td>
</tr>
</tbody>
</table>

**Related concepts:**

- “Rational Software Architect Design Manager Import Engine” on page 45

**Related tasks:**

- Chapter 3, “Sharing Rational Software Architect models,” on page 45

**Related information:**

- Upload a model to the Design Management server
- Importing Rational Software Architect models
- NullPointerException Technote

## Troubleshooting the Rational Software Architect Design Manager Import Engine

If you have problems with the Rational Software Architect Design Manager Import Engine, consider the following problems and possible solutions.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The import engine does not start, or takes longer than expected to run.</td>
<td>Start the import engine again; if it is started, a message states that it is started.</td>
</tr>
<tr>
<td>After you start the import engine, a message states that the import engine is running, even though you know that it is not running.</td>
<td>In the web UI of the Design Management Server, go to the Import Definition page. Type the import engine name and click Test to see if the import engine is running.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>An import operation failed or it completed with warnings.</td>
<td>In the web UI of the Design Management Server, go to the Import Status page and review the error, warning, and information messages that relate to your import operation. When the import process completes, you can view the number of resources and elements in the report, as well as other important statistics that relate to the import process.</td>
</tr>
<tr>
<td>Model content is no longer displayed on the Design Management Server; however, the model content is displayed if you view a snapshot.</td>
<td>The import definition might be deleted. When you delete an import definition, all related imported model data is also deleted from the Design Management Server. Reimport the model data to view it on the server, or view the model through a snapshot.</td>
</tr>
<tr>
<td>On the Import Definition page, the Test button beside the import engine name displays a message that a connection is not established.</td>
<td>Ensure that the import engine ID is identical to what was specified when the import engine was configured. Import engine IDs are case sensitive.</td>
</tr>
<tr>
<td>You cannot import models onto the Design Management Server.</td>
<td>Ensure that the Design Management Server and the Rational Software Architect Design Manager Import Engine are on the same bit level. A mismatch between 32 and 64 bit levels of the Java Virtual Machine can cause significant problems.</td>
</tr>
</tbody>
</table>

**Related concepts:**

“Rational Software Architect Design Manager Import Engine” on page 45

**Related tasks:**

Chapter 3, “Sharing Rational Software Architect models,” on page 45

**Related information:**

- [Upload a model to the Design Management server](#)
- [Importing Rational Software Architect models NullPointerException Technote](#)
Chapter 4. Importing Rational Rhapsody models to the Design Management Server

Use the following steps to import Rational Rhapsody to the Design Management Server.

Importing models to the server

Before you can view IBM Rational Rhapsody models and diagrams on the Web, you must import model data to the model server by using the IBM Rational Rhapsody Design Manager Import Engine.

There are two ways to import Rational Rhapsody models:
- Manually, where you import Rational Rhapsody models on demand.
- Automatically, through a mechanism where you can synchronize the model server with remote software configuration management (SCM) servers that contain Rational Rhapsody models.

Importing Rational Rhapsody models manually

You can import IBM Rational Rhapsody models manually. A manual import is a quick method of placing model content onto the Rational Rhapsody Design Manager by creating a compressed file with the model content. You can perform a manual import in situations when you want to make a model available immediately for viewing. The compressed file must contain the entire model, so it must be compressed at the top level of your project model in Rational Rhapsody.

Procedure
1. Place all of the Rational Rhapsody model content you want to place onto the model server into a compressed file.
2. Log into the web UI as a user with import permissions.
4. On the Import page, click Browse and then navigate to the location of the archive file that contains the Rational Rhapsody model content.
5. Select the archive file that contains the model content, and then click Open.
6. Click Import. The import process begins; track the import process on the Activities page.

Note: To view the model you just imported, on the Designs menu, click Explorer. The model you just imported will appear in the Explorer view.

Creating an import definition

An import definition specifies the name of the model you want to import onto IBM Rational Rhapsody Design Manager. An import definition also specifies scheduling criteria used by Rational Rhapsody Design Manager Import Engine to publish models to the server. An import definition must be available on Rational Rhapsody Design Manager when you configure Rational Rhapsody Design Manager Import Engine.
Procedure
1. On the model server, click File, and then click Definitions. The Definitions page opens.
2. On the Definitions page, click Create Definition.
3. Enter a unique definition name and model name. For a Simulink model, enter the .mdl file name without the .mdl extension.
4. To enable importing models from MathWorks Simulink, select the Simulink domain for the definition.

   Note: To be able to import models from Simulink, Rational Rhapsody Design Manager Import Engine and Simulink must be installed on the same machine. For more information, see the topic on importing Simulink models to the Rational Rhapsody Design Management Server.
5. Enter definition schedule criteria (date and time) for a definition.

   Note: To allow the Rational Rhapsody Design Manager Import Engine to import large models more efficiently (those models with diagrams containing more than 50 elements) select the cache option checkbox. The import utility prioritizes these diagrams and places them in cache on the server.
6. Click Save.

Related concepts
- Chapter 5, “Importing MathWorks Simulink models to the Rational Rhapsody Design Management Server,” on page 57

Related tasks
- “Configuring the Rational Rhapsody Design Manager Import Engine”

Configuring the Rational Rhapsody Design Manager Import Engine

Before you start the IBM Rational Rhapsody Design Manager Import Engine, you must set it up correctly. Typically, you configure the import engine once for each computer. For example, if your team has five separate computers that contain model content for the Design Management Server, your team must configure the import engine on each of the individual computers.

Before you begin

Before you configure the import engine, you must ensure that the Jazz Team Server where you want to import the models is started. To start the server, click Start > All Programs > IBM Rational Design Manager > Start the Jazz Team Server. In the Tomcat command window, wait for this message: INFO: Server startup in # ms. This step might take a while to complete the first time that you start the server; however, on subsequent instances, the server starts faster.

Also, if you plan to import Simulink models, MathWorks Simulink must be installed before you configure the import engine.

Procedure
1. Click Start > All Programs > IBM Rational Rhapsody Design Manager Import Engine > Configure import engine. The Rational Rhapsody Import Engine configuration utility opens.
2. In the **Server URL** field, enter the fully qualified host name of the Rational Rhapsody Design Manager server URL, such as `https://[fully qualified hostname]:9443/dm`; the front server URL must point to the computer that hosts imported model content.

3. Enter the appropriate credentials for the Jazz User Account and Jazz User Password. You should create an administrator or functional user that is responsible for placing model content onto the server.

4. Click **Connect**. When you are successfully connected to the Rational Rhapsody Design Manager, a list of available definitions is displayed.

5. Select a definition from the **Active Definitions** list.

6. Under **Local URL**, specify a directory for each model to be imported onto the Rational Rhapsody Design Manager.

7. In the model directory, browse to the Rational Rhapsody project .rpy file or, if you import Simulink models, the .mdl file.

8. If you plan to import Simulink models (and MathWorks Simulink is already installed), click **Set Simulink Path** to open the Set Path window so that you can set the path for Simulink. This connection has to be done only once on each computer. Wait for the Set Path window to open.
   a. In the Set Path window for Simulink, click **Add Folder** and browse to where the Rational Rhapsody Design Manager Import Engine was installed and select the mscripts folder (for example, `C:\Program Files\IBM\RhapsodyDMImportEngine\mscripts`), and then click **OK**.
   b. In the Set Path window, click **Save**.

9. In the Rational Rhapsody Import Engine window, click **Save and Exit**.

**Results**

After you configure the import engine, it starts automatically. The import engine is a background process that runs until you stop it. To start the import engine, click **Start > All Programs > IBM Rational Rhapsody Design Manager Import Engine > Start import engine**. The Start menu also contains an option to stop the import engine.

**Related concepts**

- Chapter 5, "Importing MathWorks Simulink models to the Rational Rhapsody Design Management Server," on page 57

**Related tasks**

- "Creating an import definition" on page 53

---

**Troubleshooting Rational Rhapsody Design Manager Import Engine**

If you have problems with IBM Rational Rhapsody Design Manager Import Engine, consider the following problems and possible solutions.

<table>
<thead>
<tr>
<th>Problem</th>
<th>What to check</th>
</tr>
</thead>
<tbody>
<tr>
<td>The import engine does not start, or appears to hang.</td>
<td>Try starting the import engine again; if it has started, a message will appear stating that is has started.</td>
</tr>
<tr>
<td>Problem</td>
<td>What to check</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
</tr>
</tbody>
</table>
| On Linux, models are not importing correctly or cannot be explored. | Try terminating the following processes on the Linux server:  
  • inner-watchdog  
  • regss  
  • mwrpcss  
  • RhapsodyCL.exe  
  • modelserver.exe |
Chapter 5. Importing MathWorks Simulink models to the Rational Rhapsody Design Management Server

IBM Rational Rhapsody Design Manager integrates with MathWorks Simulink so that designers and project stakeholders can publish and collaborate on Simulink models.

Your team can search, view, review, mark up, and analyze Simulink models and Rational Rhapsody designs in a central location that can be accessed easily through a web client. Links can be created with Simulink elements that can provide traceability into the overall product lifecycle to help manage and understand the impact of design changes.

This topic refers to the method to use the Rational Rhapsody Design Manager Import Engine to import MathWorks Simulink models, which includes the ability to schedule importing. To use the Simulink Manual Importer to manually import MathWorks Simulink models to the Rational Rhapsody Design Management Server, see the related topic on manually importing MathWorks Simulink models.

With this integration, you can publish Simulink models to a Jazz-based repository with access using Rational Rhapsody Design Manager.

For the latest installation and configuration information on importing MathWorks Simulink models, see the Design Management Documentation wiki.

Prerequisites

The following products must be installed for the integration:

• Rational Rhapsody Design Manager Server Extension with the selection to integrate with MathWorks Simulink so that the Simulink plug-in that is provided as part of the server installation is also installed. This server might be installed on a computer other than where you might be located.

• Rational Rhapsody Design Manager Import Engine on the same computer where you have Simulink installed.

• Simulink on the same computer where you have Rational Rhapsody Design Manager Import Engine installed.

Procedure

After the products are installed, on the computer where you have Simulink and Rational Rhapsody Design Manager Import Engine installed, do the following set-up tasks:

1. Create an import definition and use the Simulink domain for that definition. You can schedule how often the import engine checks for model updates. See the related topic on creating an import definition.

2. Complete a one-time connection between Simulink and Rational Rhapsody Design Manager Import Engine through the Rational Rhapsody Import Engine window. See the related topic on configuring the import engine.
Manually importing MathWorks Simulink models

You can use the Simulink Manual Importer to manually import MathWorks Simulink models to the IBM Rational Rhapsody Design Management Server.

Note: To use the Rational Rhapsody Design Manager Import Engine to schedule the automatic importing of Simulink models, see the related topic on importing Simulink models to the Rational Rhapsody Design Management Server.

Configuration

Procedure

This procedure needs to be done only once. This procedure sets up the MathWorks Simulink application to realize the Simulink Manual Importer add-on.

   For information on how to install the Simulink Manual Importer, see the related topic on installing the Rational Rhapsody Design Manager Client Extension.

2. On the Set Path window, click Add Folder, browse to where you installed Simulink Manual Importer, select the mscripts folder (for example: C:\Program Files\IBM\Rational\Rhapsody\SimulinkManualImporter301\mscripts), and click OK.

3. In the Set Path window, click Save.

Export models to the Rational Rhapsody Design Management Server

Before you begin

Before you can export MathWorks Simulink models to the Rational Rhapsody Design Management Server, you must configure the server with the Simulink Integration. The server machine might be installed on a computer other than where you might be located.

In addition, verify that your project area is actively managed on the Rational Rhapsody Design Management Server, and add the Simulink domain to the project (project properties).

Procedure

1. Open a Simulink model (.mdl) file.

2. From the Tools menu, expand the Rhapsody Design Manager section and open the Export model window.

3. Complete all the required fields, and click Export.

4. For tracking export progress, see the information displayed in the Output section and in the Simulink Command window.

Related concepts

Chapter 5, “Importing MathWorks Simulink models to the Rational Rhapsody Design Management Server,” on page 57

Related tasks

“Installing the Rational Rhapsody Design Manager Client Extension” on page 40
Navigating to MathWorks Simulink models in Rational Rhapsody Design Manager

After all installation and configuration tasks are completed, you can navigate to Simulink models in IBM Rational Rhapsody Design Manager by using the Rhapsody Design Manager section on the Tools menu.

See the related links for topics about installing and importing.

**Procedure**

1. Open a Simulink model (.mdl) file.
2. From the Tools menu, expand the Rhapsody Design Manager section and open the Navigate to Design Manager window.
3. Complete all the required fields (project area name is optional), and click Go.
4. On the default web browser, navigate to the location of an already exported model on the Rational Rhapsody Design Management Server. If necessary, enter your user name and password to access the resource.
Index

A
ant scripts
importing models to the server 50

C
client extension
installing for Rhapsody Design Manager
Eclipse 41
Linux 42
configuration
DB2 database 12
Oracle database 14
Rhapsody client 43
Simulink 54
SQL Server database 15

D
DB2 database
setup 12
design management
troubleshooting 55
upgrading 1
Design Management Server 40
ant scripts to import models 50
importing Rational Software Architect models 45
importing Rhapsody models 53
installing 10
designs
importing Rational Software Architect models 45
downloading
installation files 9

E
Eclipse
installing client extension
Rhapsody Design Manager 41

I
import definitions
creating (Rational Software Architect) 54
creating (Rhapsody) 48
import engine
description 45
Rhapsody configuring 54
importing
import engine overview 45
importing (continued)
Rational Software Architect models 45
requesting (Rational Software Architect) 50
Rhapsody models 53
manual 53
overview 53
Simulink models 57
Simulink models manually 58
installation 10
components (Rational Software Architect) 35
components (Rhapsody) 38
design management client (Rational Software Architect) 37
Design Management Server 10
Rhapsody Design Manager
client extension (Eclipse) 41
client extension (Linux) 42
sample project 35, 38
Simulink Manual Importer 40
topologies for Rational Software Architect 8
topologies for Rhapsody 9
trial version 37

L
Linux
installing client extension
Rhapsody Design Manager 42

M
models
importing Rhapsody models to the server 53
navigating to Simulink models 59

N
navigating
to Simulink models 59

O
Oracle database
setup 14

P
projects
importing 48
installing sample 35, 38

R
requests
import operations (Rational Software Architect) 50
Rhapsody Design Manager
configuring import engine 54
installing the client extension
Eclipse 41
Linux 42

S
server extensions
installing 10
setup
DB2 database 12
Oracle database 14
SQL Server database 15
Simulink
configuring 54
import definitions 54
importing models 57
navigating to models 59
Simulink Manual Importer 58
installing 40
SQL Server database
setup 15

T
topology
departmental (Rational Software Architect) 8
departmental (Rhapsody) 9
distributed (Rational Software Architect) 8
distributed (Rhapsody) 9
evaluation (Rational Software Architect) 8
evaluation (Rhapsody) 9
trial version
installation 37
troubleshooting
design management 55

U
upgrades
design management 1

W
workspace
importing 48